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ABSTRACT
CONTROLLED CODELIVERY OF MIR-26A AND ANTAGOMIR-133A WITH
OSTEOCONDUCTIVE SCAFFOLDS TO PROMOTE HEALING OF LARGE BONE
DEFECTS
FEBRUARY 2022
COLE JAMES FERREIRA, B.S, UNIVERSITY OF RHODE ISLAND
M.S, UNIVERSITY OF MASSACHUSETTS AMHERST
Directed by: Professor. Seth Donahue
Often caused by trauma or tumor removal, large bone defects frequently result in
delayed or non-union. The current gold standard for treatment is autograft. However, due
to limitations, such as the size and location of the defect, these cannot always be utilized.
A common alternative to autograft is the use of BMP-2 with a collagen scaffold, however,
this treatment is limited by numerous side effects. In recent years, genetic materials such
as microRNAs (miRNAs) have offered possible alternative therapies. MiRNAs are small
non-coding RNA molecules that generally range from 20-24 nucleotides, serve as
repressors of gene expression, and are involved in a wide range of biological activities.
Their functions can be inhibited or upregulated by delivering antagomiRs or miRNA
mimics, respectively. Two miRNAs involved in bone regeneration are of particular interest
in this study, miR-26a and miR-133a. Previous studies demonstrated miR-26a is involved
in osteoblastic differentiation and miR-133 is a negative regulator of Runx2, the key
transcription factor of osteogenesis. Therefore, we hypothesized the delivery of miR-26a
and antagomiR-133a will increase bone formation in critical-sized bone defects. The
research outlined in this thesis investigates the healing efficacy of these genetic cargos
delivered by novel peptide nanoparticles, RALA, soak loaded into a collagenhydroxyapatite scaffold.
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To test this hypothesis, scaffolds soak-loaded with RALA/microRNA were
implanted into calvarial defects in Wistar Rats. The defects were then left to heal for 8
weeks and were longitudinally monitored using micro-computed tomography (µCT). At 8
weeks, rats were euthanized and calvaria tissue was harvested for histological analysis.
The µCT data demonstrates that the scaffolds with microRNAs show promise as a
novel therapy for bone defects. The histological analysis showed the treatments promote
healing by normal bone formation activity. While there was no statistical difference (p ≥
0.11276) between groups for the healing variables, this is believed to be due to the small
sample size and low power (60%). All of the miRNA treatment groups had samples with
considerably higher healing responses than the gene-free group. In conclusion, the findings
of this study support the use of this cell-free implant system as a potential novel clinical
therapy, as an alternative to bone grafting, for treating large bone defects.

vi

TABLE OF CONTENTS
Page
ACKNOWLEDGEMENTS……………..……………………………………………...iv
ABSTRACT…………………………………………………………….………………...v
LIST OF TABLES………………………………..……………………………………..ix
LIST OF FIGURES………………………………………………………………..……..x
CHAPTER
1. INTRODUCTION, LITERATURE REVIEW, AND AIMS...……………………....1
1.1 Bone Physiology and Fracture Repair……………………….………...………1
1.2 Non-Union Fractures……………………………………………….………….4
1.3 Clinically Used Bone Grafts and Bone Graft Alternatives………….…………5
1.4 Animal Models………………………………………………………………...9
1.5 Protein Therapy………………………………………………………………14
1.6 Gene and RNA Therapy……………………………………………………...16
1.7 Summary……………………………………………………………………..25
1.8 Hypothesis and Aims………………………………………………………...26
1.9 References………………………………………………………………...….27
2. MIR-26A PILOT STUDY…………………….………………………………...……36
2.1 Introduction…………………………………………………………..………36
2.2 Methods……………………………………………………………………....38
2.3 Results……..…………………………………………………………………46
2.4 Discussion…………………..………………………………………………..49
vii

2.5 Conclusion…………………………………………………………….……..51
2.6 References……………………………………………………………………51
3. MIRNA HEALING EFFICACY……………………..…………………………...…53
3.1 Introduction…………………………………………………………..………53
3.2 Methods…………………..…………………………………………………..55
3.3 Results………………………………………………………………………..63
3.4 Discussion…………………………………………………………...……….70
3.5 Conclusion and Future Directions…………………………………...…….…73
3.6 References…………………………………………………………..………..73
APPENDICES
A. Soak-loaded Collagen-Hydroxyapatite Scaffold Preparation Protocol………76
B. Calvarial Defect Surgical Procedure Protocol………………………………..78
C. Micro-Computed Tomography of in vivo Rat Calvaria (µCT)………………..82
D. Rat Euthanasia and Calvaria Tissue Collection………………………………89
E. Calvaria Histological Processing Protocol…………………..……………….91
F. Histomorphometry Analysis Protocol……………………………...…..…….93
REFERENCES………………………………………………….………………………98

viii

LIST OF TABLES
Table

Page

2.1: A summary of each treatment and Cy5 concentration received by each rat………...40

ix

LIST OF FIGURES
Figure

Page

1.1: a.) 3D renderings of 7-mm unilateral calvarial defects at 4 weeks after being treated
with a gene-free collagen-hydroxyapatite scaffold. b.) 3D renderings of 7-mm unilateral
calvarial defect 4 weeks after being treated with 2.5ug rhBMP-2 and 2.5ug rhVEGF-165
on a collagen-hydroxyapatite scaffold [86]………………………………..….………….12
1.2: miR26-a enters the cytoplasm and is loaded into the RNA-induced silencing complex
(RISC). With the assistance of RISC, miR-26a binds with SOSTDC1 mRNA. This leads
to rapid translation repression which causes the degradation of the mRNA. SOSTDC1
inhibits BMPs and the Wnt/ β-catenin…………………………………..……………..…19
1.3: AntagomiR-133a directly binds to miR-133a stopping it from inhibiting Runx2,
therefore, leading to osteoblastic differentiation…………………………………………20
1.4: The RALA nanoparticle complex, containing the genetic cargo, leaves the scaffold
and is taken up into the cell via endocytosis. The lower pH inside the endosome then causes
a conformational change in the RALA peptide. This change allows the peptide to fuse with
the endosomal membrane and cleaves the genetic cargo releasing it into the cytoplasm
where it is loaded into the RNA-induced silencing complex……………………….…….25
2.1: Bone Volume at weeks 4, 8, and 12 (p=.47762). Mean ± SE….………………...……46
2.2: Tissue Mineral Density at weeks 4, 8, and 12 (p=.3334). Mean ± SE……………...…47
2.3: IVIS imaging of the rats 3- and 5-days post calvarial defect surgery. No fluorescence
was detected in any of the concentrations at either timepoint……………………….……47
2.4: IVIS imaging of the detectable nanoparticles at different time points post subcutaneous
implant. The yellow circle represents the approximate region of interest………………...48
2.5: In vivo fluorescence of the detectable 1.5:1 ratio nanoparticles. Nanoparticles were
detectable between days 1 and 28 when the study was terminated………………………..49
3.1: The two different VOI’s used to analyze µCT data. The left image shows the large
VOI and the right image shows the small ROI…………………………………….….…..60
3.2: 2D Representative coronal view images of the percent of bone filled within the defect
region collected from the µCT scans. White represents bone………………………..…...64
3.3: Bone Volume of the large VOI (p=0.13875). Mean ± SE ……………………………64
3.4: Tissue Mineral Density of the large VOI (p=0.44569). Mean ± SE ………………….65
3.5: Bone Volume of the small VOI (p=.14126). Mean ± SE ………………………...…..65
3.6: Bone Mineral Density of the small VOI (p=0.11276). Mean ± SE …………………..66
3.7: Tissue Mineral Density of the small VOI (p=0.61887). Mean ± SE ……………...….66
x

3.8: Percent Filled of the small VOI (p=0.20349). Mean ± SE ……………………...……67
3.9: Representative images of the calvaria cut on the transverse plane and stained with
H&E. Red lines represent the measurements used for the defect width calculation.
Magnification at 80x………………………………………………………………….….67
3.10: Defect Width from the H&E Stains (p=.1646). Mean ± SE ….…………………......68
3.11: New bone area from the H&E stains (p=.1325). Mean ± SE……………………..…68
3.12: Correlation between Bone Area from the H&E stains and the Bone Volume from the
small ROI (R2=0.8739) (p<.0001)……………………………………...……………..…69

xi

CHAPTER 1
INTRODUCTION, LITERATURE REVIEW, AND AIMS
1.1 Bone Physiology and Fracture Repair
Bone is a complex, dynamic, and unique tissue that assists in a wide array of
functions such as structural support, protection of internal organs, maintenance of mineral
homeostasis, and growth factor and cytokine storage. Bone matrix is composed of 50-70%
mineral, 20-40% organic matter, and 5-10% water [93]. The mineral phase mainly consists
of small hydroxyapatite crystals that support mineral metabolism [93]. The organic phase
is primarily made of collagenous proteins, with type I collagen being the most abundant
[93]. Three main cell types exist within this matrix: osteoblasts, osteoclasts, and osteocytes.
Osteoblasts are responsible for secreting new bone matrix, known as osteoid, and enzymes
that facilitate the mineralization process. Osteoclasts are involved in bone resorption and
are generally found on free surfaces of bone tissue. Osteocytes are formed when osteoblasts
become embedded in secreted osteoid and assist in cell signaling. These three cell types
are always working in unison to grow, repair, and remodel bones.
Bone material is generally classified into two types; cortical bone, also known as
compact bone, and trabecular bone, also known as cancellous or spongy bone. These two
types are classified according to their porosity and microstructures. Cortical bone is a high
density (~1.6-2.0 g/cm3), low porosity (~3-12%) tissue [93, 103, 104]. Trabecular bone is
a low density (~.79-.9 g/cm3), high porosity (~70-90%) foam-like network of struts [93,
105]. In humans, the skeleton is composed of 80% cortical bone and 20% trabecular bone
[93]. Most bones are comprised of a combination of both cortical and trabecular bone. The
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human skull, for example, is identified by a layered bone structure where the trabecular
bone is sandwiched between outer cortical bone layers [106].
On a larger scale, whole bones fall into four broad categories – long bones, short
bones, flat bones, and irregular bones – with the two most common being long and flat
bones. Each type of bone has different structures, roles, and healing processes. As their
name suggests, long bones are much longer than their width and primarily act as levers to
support movement. The majority are regenerated through a process known as endochondral
ossification, which is when cartilage is systematically replaced with bone. Examples of
long bones include the femur, fibula, tibia, humerus, radius, ulna, metacarpals, and
phalanges. Flat bones, on the other hand, provide large surfaces for muscles to attach and
protect internal organs. However, these bones heal primarily through a different process
known as intramembranous ossification which is direct bone formation. The cranium,
pelvis, sternum, and rib cage are all examples of flat bones.
Bone is unique as it is one of the few tissues that can heal without the formation of
a fibrous scar [94]. While the healing process is not fully understood, normal bone healing
is generally broken into three considerably overlapping phases, inflammation, formation,
and remodeling [5]. The inflammation stage begins immediately after injury and is similar
to other wound healing responses [6,7]. This stage is crucial for infection prevention and
proper bone repair [6,7]. Similar in both long and flat bones, two main events take place
during this phase, hematoma formation and a fierce cell infiltration [7]. This consists of the
migration of inflammatory cells such as macrophages, platelets, and monocytes to the
injury site as well as an increase in cytokine expression [7]. These cells begin showing up
within the first 24 hours after injury [108].
2

Overlapping with inflammation is the bone formation stage. This phase is where
the distinct difference between endochondral and intramembranous ossification is seen.
The largest difference is endochondral ossification's use of chondrocytes to form a cartilage
template for bone formation [8]. This starts with mesenchymal stem cells (MSCs) flooding
the injury site and differentiating into chondrocytes [9]. These chondrocytes synthesize a
cartilage matrix that replaces the originally established hematoma [7]. During this process,
the chondrocytes go through phases of proliferation and prehypertrophy before becoming
hypertrophic [10]. The hypertrophic chondrocytes increase their expression of matrix
remodeling enzymes and matrix components such as MMPs, aggrecanases, and COLX, as
well as VEGF-A, which drives the formation of blood vessels throughout the template
[10,11]. These chondrocytes finally go through apoptosis before serving as sites for
calcium-phosphate crystals to start calcifying the matrix [7]. This results in a calcified
cartilaginous matrix that is slowly replaced with bone during the bone remodeling stage.
Conversely, the intramembranous bone formation stage is a more direct process.
This process begins with the recruitment of osteoprogenitor cells from several locations in
the body including bone marrow, periosteum, and neighboring soft tissues [14]. As early
as 7 days after injury, these cells begin differentiating into osteoblasts, which can begin
direct secretion of the extracellular matrix consisting of osteoid [15]. This formation stage
results in a disordered and mechanically fragile bone known as woven bone. However, this
is replaced by lamellar bone, an organized arrangement of collagen fibers, during bone
remodeling [7].
Even though these two ossification modes differ during the bone formation stage,
they share similarities during the coinciding remodeling stage. This stage is driven by the
3

continuous migration of osteoclasts and osteoblasts [98]. Osteoclasts and osteoblasts work
together in this stage to continuously resorb and secrete new bone. This balance of
resorption and formation is known as “coupled remodeling” and can last months to years
until normal bone structure, shape, and size are restored. Despite these healing processes
being commonplace in small simple fractures, occasionally in larger complex fractures
these healing responses do not progress as intended and result in non-union healing.
1.2 Non-Union Fractures
Non-Union fractures are defined by the American Food and Drug Administration
as being “established when a minimum of nine months has elapsed since injury and the
fracture shows no visible progressive signs of healing for three months” [1]. Approximately
6 million bone fractures occur in the United States annually and it is estimated that 5-10%
of these fractures result in either delayed or non-union healing [2,3].
These injuries are commonly caused by either trauma or tumor removal. Traumatic
injuries often are a result of traffics accidents, gunshot wounds, falls, or blast injuries [19].
These high-impact injuries can often leave the bone with fractures too large for natural
healing to occur. Tumor removal in bone can also lead to non-union healing since a resected
tumor leaves behind a segmental defect at the once cancerous site. In smaller tumor sites
this is a non-issue; however, in larger masses, this segmental defect becomes a problem of
its own [21].
While these injuries can happen for many reasons, certain factors have been
identified that can increase the risk of non-unions from occurring. Host factors including
smoking, age, gender, and diabetes can increase the likelihood of non-union fractures [16].
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Examples of this include one study that showed 57% of non-union fractures occur in males
and 43% in females with injuries peaking at ages between 35-44 years old [17]. Another
study found that smokers are twice as likely to experience non-union fractures than nonsmokers [18]. In addition to host factors, biological factors such as lack of vascularization,
infection, and degree and location of bone loss can also contribute to healing complications
[16]. This is especially true in combat injuries, where treatments have an increased
likelihood of being administered in unsanitary conditions. One study found that 15% of
orthopedic injuries in combat zones result in infection [20].
These non-union fractures can be divided into four distinct categories:
hypertrophic, atrophic, avascular, or pseudoarthrosis [101]. The most commonly occurring
type is hypertrophic, which is when the fracture results in non-union despite the formation
of a large callus around the fracture site. Atrophic non-unions occur when little to no callus
forms and bone resorption still takes place. Avascular non-unions arise when there is a lack
of blood supply to the defect region. Finally, pseudoarthrosis non-unions develop when
excess motion occurs at the fracture location. Each of these non-union types is unique and
needs to be taken into consideration when selecting or designing applications for bone
repair.
1.3 Clinically Used Bone Grafts and Bone Graft Alternatives
Clinically Used Bone Grafts
Autografts and allografts are the current gold standard treatments for non-union
fractures and are utilized in 2.2 million orthopedic procedures each year [22]. Autografts
are the leading treatment option as they are taken from a healthy site in the same patient’s
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skeleton and are genetically similar to the absent bone. They can provide the necessary
cells, proteins, and matrix to the defect site with minimal immunogenic complications [23].
They are easily incorporated into the defect site due to vascularization; it is suggested that
if vascularization of the graft is successful then up to 90% of the cells can survive [24].
While this is the ideal solution for non-unions it is not always a viable one. Depending on
the magnitude and location of the defect, the collection of an autograft might result in the
formation of another non-union injury. Some authors have recommended not using
autografts in defects larger than 5 cm [26]. In addition, patients have also experienced
chronic pain in donor sites for months following grafting procedures [25].
Alternatively, allografts are also widely used in these orthopedic procedures, and
provide a great substitute to autografts. Allografts have increased availability compared to
autografts, as they can be harvested from both living and nonliving donors. The donor
tissue has to be processed before implantation which reduces its osteoinductivity, protein
concentration, and mechanical properties, but still allows it to still be osteoconductive [27].
In the past, disease transmission has also been an area of concern however current
processing methods have been specifically designed to limit transmission [28]. As a whole,
allografts limitations, such as cost, laborious processing, mechanical stability, limited
osteoinduction, and infection are still a concern. Due to these concerns, animal bones have
also been utilized for xenografting procedures.
Xenografts, usually harvested from bovine and porcine, can be demineralized and
deproteinized for bone grafting procedures. Generally, these are the least commonly used
and are only utilized as calcified matrixes [27]. The overall effect of these bone grafts is
widely debated with some papers showing favorable results such as high availability, easy
6

accessibility, osteoconductivity, good mechanical properties, and low costs [27]. Other
studies claim low availability and show that up to 25% of xenograft procedures result in
complications [29]. Due to these complications, scientists have looked towards alternative
ways of treating these non-union bone defects.
Clinically Used Bone Grafting Alternatives
When it comes to bone grafting alternatives, a selection of both natural and
synthetic materials has been used in clinical applications. Commonly seen alternatives are
ceramics, polymers, bioactive glasses, and composites, each with advantages and
disadvantages.
Ceramic bone substitutes are calcium-based and are primarily calcium sulfates or
calcium phosphates. Calcium sulfate was the first therapeutic material to be reported as a
bone substitute, dating back to 1892 [27]. It is bio-inert, osteoconductive, and cost-efficient
[99]. Due to its rapid resorption rate, it is used as an effective gap filler allowing for
vascularized fibrous tissue to take its place [27,99]. However, this high resorption rate often
results in problematic inflammation [27]. Calcium phosphates can be classified into two
main groups: crystalline hydroxyapatite, and its amorphous phase, tri-calcium phosphate
[27]. Hydroxyapatite, the main mineral component of bone, comes in both natural and
synthetic forms [27]. It is a relatively inert substance with a slow resorption rate and high
mechanical strength. Tri-calcium phosphate, on the other hand, has poor mechanical
properties but a fast resorption rate [27]. Due to these offsetting properties, hydroxyapatite
and tri-calcium phosphate are often used in unison [27]. This calcium sulfate composite
then provides balanced mechanical support and resorption rate.
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First developed in the 1970s, bioactive glasses – also known as bioglasses – are
biocompatible, osteoconductive, and oftentimes porous structures that promote bone
resorption and formation [31]. They are silica-, phosphate-, or borate-based glasses that
are coupled with other minerals naturally found in the body [31]. They do not elicit an
inflammatory response, and their resorption rate is tunable based on the composition [31].
While they strongly adhere to the native bone, they are quite brittle and have poor
mechanical strength and fracture resistance [31]. Thus, they are often used in combination
with other bone graft substitutes.
More recently, polymer bone substitutes have been coming into the limelight. Due
to their wide variety of physical, mechanical, and chemical properties, these scaffolds can
be printed or molded into any shape or form desired. Polymers are extremely tunable and
can be designed to be fully-, partially-, or non-degradable depending on the requirement
[27]. Due to their unique tunable environment, many polymer scaffolds are used to deliver
a wide range of growth factors, cells, and antibiotics. Polycaprolactone for example can be
synthesized to mimic the structure of the bone extracellular matrix, offering a porous
environment and osteoconductive properties [33]. However, other polymers have been
shown to inhibit bone growth rather than promote it [34,35]. Ultimately, polymers offer a
wide range of materials and structures for many different bone repair applications but
should be carefully selected.
Often, the best solution for a bone graft material is a combination of several.
Composite materials for bone grafting include scaffolds made of collagen and
hydroxyapatite, two of the most abundant materials found naturally in the bone. Both
collagen and hydroxyapatite have been found to enhance osteoblastic differentiation and
8

osteogenesis [36]. These composites have been proved to be biocompatible in vitro and in
vivo [37]. The collagen-hydroxyapatite scaffolds also have mechanical advantages
compared to collagen and hydroxyapatite alone. Hydroxyapatite's poor fracture toughness
can be balanced out by the ductile properties of collagen [27]. In addition, calcium and
phosphate are also sometimes added to increase stability and mechanical properties
[27,38,102]. Furthermore, their porous architecture allows them to uptake cells and deliver
therapeutic agents.
Overall, there is currently no perfect solution for the regeneration of non-union
fractures. Clinical biomaterials in combination with growth factors have had success but
not without their disadvantages, which will be discussed later. More work is clearly needed
to find the best autograft substitute and become the new gold standard for non-union
fractures.
1.4 Animals Models
When testing new treatments for non-union injuries animal models are often
utilized. These animal defect models provide a reliable and reproducible environment for
evaluating tissue engineering applications before translating them to a clinical setting. For
bone regeneration, many different animal models are utilized, the most popular being rats,
followed by rabbits, mice, and sheep [39]. There is no correct answer to which animal
model is best, with each having different characteristics that could be best suited for
specific studies. Smaller animal models are more often seen for histological and molecular
analyses while larger animals are more typical for biomechanical analyses [39]. Rats are
the most routinely used due to their quick healing response, high reproducibility, multiple
assessment strategies, ease of use, limited morbidity, and simple tissue collection process.
9

It is normal practice to use skeletally mature rats so that natural bone growth does not
provide confounding results. Both male and female rats have been used in bone defect
studies. Male rats provide larger bones and less delayed healing, while female rats can
provide an osteoporotic model [40].
To evaluate non-union fractures using these animals, critical-sized defects are created.
Critical-sized defects are defined as “defects of a size that will not heal during the lifetime
of the animal” [95]. Critical-sized defects are often created in the calvaria, long bones, and
mandible of rats. The calvarial defect, a flat bone model, heals via intramembranous
ossification [41]. Long bone defects, commonly the femoral defect, heal via endochondral
ossification [41]. Less frequently seen is the mandible defect, which allows for the
evaluation of craniofacial injuries.
Calvarial Defect
The calvarial defect model in small rodents, such as rats, is a versatile model that
allows for the evaluation of intermembranous ossification in a non-load-bearing orthotopic
site. The procedure itself is easily reproducible, minimally invasive, and requires less
surgical expertise to perform. While a calvarial defect is generally accepted to be critical
at 8mm in rats, defects as small as 2.3mm, and as large as 9mm have been used [42,96].
However, factors such as size, species, length of study, age, and defect location all play a
role in the healing response. These smaller defects are beneficial as they allow for smaller
animals to be used and offer the potential for bilateral defects to be made in a single skull.
However, the use of bilateral defects needs to be carefully considered as interactions
between two adjacent defects can arise [42].
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The rat calvarial defect is accomplished with the use of a trephine in combination
with a dental drill. The trephine is pushed gently against the calvarium making sure not to
damage the caudal and cranial sutures, as this results in hemorrhaging. When removing the
bone, it is essential not to damage the underlying dura mater, as it potentially plays a role
in bone regeneration and healing. The therapeutic construct being evaluated is then
inserted into this defect region. Due to the location and nature of the defect, the region does
not need fixation, adding to the ease of this method as well as eliminating any
complications caused by fixation plates. Fixation plates have been shown to cause cortical
porosity, delayed bridging, and refractures upon removal [43]. The periosteum is often
placed back over the defect site and sutured together as it contains mesenchymal progenitor
cells, differentiated osteogenic progenitor cells, and osteoblasts that play important roles
in intramembranous ossification [44]. Finally, the skin is closed completing the defect.
The ideal goal in utilizing the calvarial defect is to achieve full union healing within
the defect region in a timely manner. Some good examples of this have been demonstrated
by the delivery of BMPs. One study demonstrated near-complete 8 mm defect healing
using 2 µg of BMP-2 delivered via hydrogel after 6 weeks in male Sprague Dawley rats
[107]. However, this study also demonstrated the ectopic bone formation caused by BMP2. Another study showed that the codelivery of 2.5 µg BMP-2 and 2.5 µg VEGF via a
collagen-hydroxyapatite scaffold was able to 80% fill a defect in as quickly as 4 weeks
(figure 1.1) [86]. These serve as excellent positive controls when referencing the
osteogenic potential of biomaterials and therapeutics. Oftentimes, empty defects without
treatment are utilized as negative controls. Due to the size and location of the defect, and
the weight, age, and species of the animal empty defects will heal at different rates if at all.
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Most empty defects do experience minimal healing and are often used to compare to the
experimental therapeutic.

Figure 1.1: a.) 3D renderings of 7-mm unilateral calvarial defects at 4 weeks after
being treated with a gene-free collagen-hydroxyapatite scaffold. b.) 3D renderings of
7-mm unilateral calvarial defect 4 weeks after being treated with 2.5ug rhBMP-2
and 2.5ug rhVEGF-165 on a collagen-hydroxyapatite scaffold [86].

Femoral Defect
For evaluating healing via endochondral ossification, long bone defects are
commonly utilized. The most common is the femoral defect. Unlike the calvarial defect,
long bones experience biomechanical stimulus which is essential for certain therapeutics
or biomaterials. In a rat femoral defect, critical-sized defects are generally defined as
anything greater than 4mm [97].
The femoral defect requires a slightly more complicated but lower-risk surgery.
The surgical procedure begins with a skin incision over the femur. Once exposed, the
diaphysis of the femur is cut with a Gigli wire creating a segmental defect. The treatment
is then placed in the defect site and the bone is stabilized with internal fixation plates.
Aforementioned, these fixation plates have been known to cause adverse effects and need
to be handled with care and precaution. After fixation, the wound is then closed completing
the defect.
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Evaluation Methods
The bone regeneration within the defects can be evaluated using several methods.
Radiological methods such as 2D x-rays and 3D micro-computed tomography can be used
to evaluate the healing efficacy of the implant. Animals are either scanned in vivo at
longitudinal time points or the bone can be harvested, fixed, and scanned ex-vivo, at higher
resolutions. From the radiological data bone mineral density, percent of defect bridged, and
new bone volume is often evaluated. A wide range of different histological stains are also
utilized for analysis, as they provide insight into the microenvironment of the new bone
formed. Histology is often used to visualize cells, proteins, and other biological factors
either qualitatively or quantitatively. Less typically seen, traditional microscopy can be
used to evaluate the microstructure of the newly formed bone. Mechanical testing can also
be done but is often only seen with long bones, as the calvaria does not experience
biomechanical loading. Testing often includes torque to failure, stiffness, and energy
absorption testing [45].
Overall, both defect models have their pros and cons that can be employed in
different ways. For evaluation of flat bone, it would be advantageous to utilize a calvarial
defect as they heal through intramembranous ossification. However, for a study that needs
biomechanical stimulus or wants to evaluate healing through endochondral ossification,
the femoral defect would be beneficial. As a whole, both models provide a unique healing
response and can be used to evaluate many bone regeneration techniques.
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1.5 Protein Therapy
Regularly used in combination with the previously mentioned biomaterials,
proteins are often delivered to the defect site to increase the bones healing response. Protein
therapy is a widely researched area as it is easily translated into clinical applications [46].
Proteins can also be easily produced in large quantities with minimal batch-to-batch
variation which makes them perfect for large-scale production [46]. These proteins are
generally growth factors, which naturally occur in the cell and are capable of stimulating
cellular growth and proliferation [16]. Growth factors that assist in bone formation include,
but are not limited to, bone morphogenetic proteins (BMP), transforming growth factor
beta (TGF-β), vascular endothelial growth factor (VEGF), and fibroblast growth factor
(FGF).
TGF-β is a cytokine that belongs to a large superfamily of growth factors and is
expressed in high levels during fracture healing [7]. It comes in three different isoforms
(TGF-β1, TGF-β2, TGF-β3) and helps initiate callus formation while also playing a role in
chondrogenesis and endochondral bone formation [7]. A study demonstrated that low doses
of TGF-β1 delivered on a human dermal collagen matrix into rabbit calvarial defects were
able to significantly increase bone regeneration when compared to that of the matrix alone
[48]. This suggests that low doses of TGF-β1 promote healing.
FGFs are a large family of cell signaling proteins that are involved in a wide range
of development processes including bone formation. Mice lacking FGF-2 experience a
decrease in bone volume, mineral absorption, and bone formation rates [51]. When
delivered by a hydrogel, FGF-2 was able to enhance bone formation compared to controls
at a time point of 2 months, however, it provided a similar response to controls at 3 months
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[83]. This data suggested that the delivery of FGF-2 can increase the rate of bone formation,
but not the volume of bone formed. Other studies have found that using FGF-2 in
combination with other growth factors contributes to the efficacy of the other growth
factor. For example, BMP-2 in combination with FGF-2 increases bone formation when
compared to BMP-2 alone [84].
VEGF is a signaling protein that stimulates the formation of blood vessels, an
important aspect of bone formation. One study found that implanting a bioactive glass
scaffold coated with VEGF increased bone formation, bone mineral density, and vascular
density when compared to the scaffold alone [85]. Similar to FGF-2, VEGF is also often
used in combination with other growth factors. BMP-2 in combination with VEGF has
filled a 7-mm calvarial defect in adult male Wistar rats up to 80% in as little as 4 weeks
[86].
Of all the growth factors, BMPs are the most intensely studied, specifically BMP2 and BMP-7 which are both licensed for commercial use in bone healing applications
[87,88]. These BMPs are part of the transforming growth factor-beta superfamily and are
naturally produced by osteoblasts. Due to their large popularity, it’s been extensively
researched in small and large animals, as well as humans [89]. BMP-2 is well known to
provide the best bone formation capabilities out of all other growth factors and has shown
significant healing progress in as little as 2 weeks [100]. It has also been shown to decrease
the risk of failure in tibial fracture by 44% [89]. As well as, have a 100% fusion rate for
spinal fusions in pediatric patients [89]. On top of these applications, it has also been
utilized in mandibular reconstruction, cleft bone defects, cranial defect closures, and cancer
treatments in humans [89].
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While BMPs sound like ideal treatment options, they do come with many pitfalls.
Initially, BMP-2 was shown to have minimal safety risks but more recent studies have
concluded that associated risks are much higher than initially thought [90]. High doses in
human spine surgeries have resulted in infection, arrhythmia, pseudarthrosis, and cancer
[91]. It has also caused heterotopic bone formation in tibiae fractures and the need for
additional surgeries in several other procedures [89,92]. Along with the previously
mentioned side effects, the administration of BMPs has also resulted in amplified
inflammatory responses, instrumentation failure, systemic toxicity, increased osteoclastic
activity, pain, and neurological deficit [89,90]. With all of these factors considered, it is
clear that other non-protein alternatives are needed.
1.6 Gene and RNA Therapy
Alternatives that are trying to overcome the hurdles of protein therapy include gene
and RNA therapies. Gene therapy involves the transfection of exogenous genes into a cell
to replace or correct an existing gene or to change the expression of a gene to get a desired
effect. In bone regeneration and repair, gene therapy has been the novel front-runner to
replace current protein therapy methods. The use of gene therapy allows for cells to
naturally produce their own proteins, restricting the potential for overdosing and adverse
side effects [46]. Similar to gene therapy, RNA therapy, also known as RNA interference,
has recently begun offering a new therapeutic approach for bone healing applications. RNA
therapy works via the transient silencing of specific genes by delivering different types of
RNA to cells [47].
Both gene and RNA therapies are often seen as a three-tiered system in bone
regeneration applications. The first tier is genetic cargo which is oftentimes DNA in the
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form of a plasmid (pDNA) or RNA in one of several different forms. The secondary tier is
the vector that is used to breach the cellular membrane and deliver the genetic cargo to the
cell. Vectors fall into two main categories – viral and non-viral – each with particular
applications and delivery mechanisms. The use of these vectors is essential as there has
been little success with direct gene delivery [49]. The most macroscopic tier is a
biomaterial scaffold. Biomaterial scaffolds, as stated previously, provide structural
support, cell attachment, and retention of newly formed tissue while also delivering the
vector and genetic cargo into the body [47]. The combination of these three tiers is known
as a gene-activated scaffold.
Genetic Cargos
As previously mentioned, genetic cargo can come in one of two forms, DNA or
RNA. DNA, often encoding for cytokines or growth factors, is generally delivered as a
plasmid. Plasmids are a great resource as they offer flexible and compatible chemistry, low
systemic toxicity, and relatively low manufacturing costs [49]. For RNA, several different
approaches have been investigated for tissue engineering such as microRNAs (miR), short
hairpin RNAs (shRNA), and short interfering RNAs (siRNA). miRs are small non-coding
RNAs that are involved in a wide range of biological activities and serve as repressors of
gene expression [50]. Their functions can be upregulated or downregulated by delivering
either miR mimics or miR inhibitors known as antagomiRs [47]. Alternatively, shRNA and
siRNA are double-stranded RNAs that induce the cleavage of complementary strands of
mRNA, therefore silencing protein production [47].
Plasmid BMP-2 (pBMP-2) is a frequently used gene for bone regenerations, as its
protein variant is already widely used clinically. Normally, BMP-2 requires large doses of
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recombinant protein, using as much as 8.4mg per patient [52]. However, as previously
mentioned, these large doses of protein can cause adverse effects [52]. Yet, doses of pBMP2 have been shown to increase calcium, collagen, osteocalcin, and in vivo bone growth with
doses as low as 2 µg [53].
In addition to pBMP-2, the delivery of other plasmids encoding for different growth
factors has also been shown to play a substantial role in bone growth. One example of this
is the plasmids encoding for VEGF (pVEGF). When coupled with pBMP-2, pVEGF was
shown to increase blood vessel and bone formation in vivo compared to pBMP-2 alone
[55]. It also showed an increase in ALP, an osteoblastic differentiation biomarker, and
calcium content in vitro, suggesting its ability to be combined with other growth factors to
increase osteogenesis [55]. One study demonstrating the difference between BMP-2 and
pBMP-2 found that BMP-2 causes a rapid, overpowering, and uncontrolled bone formation
for a longer period of time where the plasmid resulted in a desired and locally maintained
bone growth, avoiding ectopic formation [100].
In recent years, RNA has increasingly become a popular genetic cargo due to the
advantages it has over DNA delivery. One major advantage is that RNA only needs to
reach the cytoplasm to be effective while DNA needs to reach the nucleus [54]. RNA also
allows for a finer temporal control due to its specificity and transient effect [47,56,57]. In
addition to this, RNAs have a longer shelf life and higher stability when compared to pDNA
[47,56,57].
One of the most popular RNAs used for bone tissue regeneration is miR-26a. It has
been proven that miR-26a is naturally upregulated in non-union injuries and can enhance
osteogenic differentiation of mesenchymal stem cells [58]. Using bioinformatics, dual18

luciferase, and western blots, it is suggested that miR-26a directly targets sclerostin
domain-containing 1 (SOSTDC1) [58]. SOSTDC1 is an antagonist of BMPs which, as
mentioned previously, play a crucial role in bone formation and are used clinically to treat
bone defects. SOSTDC1 has also been hypothesized to be an inhibitor of the important
Wnt/β-catenin signaling pathway [59]. Therefore, the delivery of miR-26a downregulates
SOSTDC1, which in return upregulates BMP and Wnt/β-catenin activity, increasing bone
formation (figure 1.2). As a result, several in vivo studies have shown that the delivery of
miR-26a or MSCs overexpressing miR-26a increases bone volume, bone mineral density,
osteoblast number, and Runx2 expression [60,61].

Figure 1.2: miR26-a enters the cytoplasm and is loaded into the RNA-induced
silencing complex (RISC). With the assistance of RISC, miR-26a binds with
SOSTDC1 mRNA. This leads to rapid translation repression which causes the
degradation of the mRNA. SOSTDC1 inhibits BMPs and the Wnt/ β-catenin.
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AntagomiRs are used to inhibit the functions of microRNAs. One example of this
is the use of antagomiR-133a to inhibit miR-133a. MiR-133a has been identified to be a
negative regulator of Runx2, the key transcription factor of osteogenesis (figure 1.3) [62].
This makes it an ideal target for inhibition in order to upregulate osteoblastic
differentiation. Initial in vitro experiments, showed that antagomiR-133a, delivered with
nanohydroxyapatite particles on a collagen-hydroxyapatite scaffold, was able to cause an
eight-fold increase in Runx2 expression, a seven-fold increase in osteocalcin, and an
increase in alkaline phosphatase and calcium [63]. An in vivo calvarial defect study also
showed increased calcium concentration and an increase in bone volume [64]. In addition
to bone growth, on a cellular level, it was found that antagomiR-133a caused an increase
in the M2-like macrophage population, which help accelerate healing [64]. However, a lot
is still elusive about miR-133a and its role in bone formation, and further research is still
required.

Figure 1.3: AntagomiR-133a directly binds to miR-133a stopping it from inhibiting
Runx2, therefore, leading to osteoblastic differentiation.
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Vectors
A key aspect of delivering any nucleic acid is the vector – the vehicle that delivers
the cargo inside the cell. These vectors are essential as there has been minimal success with
direct nucleic acid delivery due to off-targeted localization, degradation, and poor cellular
uptake [49]. Vectors often fall into two distinct categories: viral and non-viral. More
commonly known, viral vectors have been the gold standard due to their high transfection
rates, high transgene expression levels, and persistent and stable gene expression [47].
However, they are also associated with toxicity, limited loading capacities,
immunogenicity and are expensive to produce in large quantities [65]. While non-viral
vectors are less efficient, they are often considered safer, cheaper, and easier to produce
[46,47].
Viral vectors have been the preferred method for genetic therapeutic delivery. As
of 2018, all approved human treatments utilizing gene therapy have used viral vectors [47].
This is due to their popularity and high cell transfection efficiency of about 80-100% [47].
However, as previously stated they do have risks including toxicity, limited loading
capacities, immunogenicity, the potential for oncogene transactivation, and leukemia
[47,65,66,67]. That being said, great strides have been made to develop safer viral vectors,
but some of these concerns remain. Two viruses, in particular, have been tailored for bone
regeneration approaches; lentivirus and adenovirus [47]. However, both of these viruses
have shown difficulty linking to scaffolds for localized delivery [47]. While viral vectors
can be more advantageous in certain areas, non-viral vectors allow for an alternative, safer,
and cheaper approach.
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Non-viral vectors can further be classified into four distinct categories – inorganic,
lipid, polymeric, and peptide – all of which are tasked with the same goal of delivering
genetic material into the cell so that a desired change in genetic expression can take place.
Inorganic vectors consist of materials such as calcium phosphate, gold, silica, carbon
nanotubes, and iron oxides, all of which have shown successful delivery of nucleic acids
into cells [68]. These inorganic vectors have several advantages as they are easy to
manufacture, produce a low immune response, are highly biocompatible, have high
stability, and are resistant to microbial attacks [47]. For example, gold nanoparticles are a
promising inorganic system as they have a high surface area and the possibility of surface
functionalization with nucleic acids [69]. Additionally, gold nanoparticles have been
shown to successfully deliver microRNAs to bone mesenchymal stem cells [70]. Iron oxide
particles are also a popular delivery system due to their small size and magnetic properties.
They have been successful in delivering genetic cargos when used in combination with
magnetic fields, making them an attractive option for large bone defects [71].
The next type of non-viral vector – lipid vectors – are small, positively charged
amphiphilic molecules that form self-assembled vesicles for delivery [47]. This
amphiphilic structure is essential for its use as a vector. The polar head allows for the
binding of the negatively charged nucleic acids, while the non-polar body allows for
interaction with the cell membrane [47]. The lipid vector can breach the cellular membrane
through endocytosis. Once the vector and cargo are inside the cell, the endosomal
membrane is destabilized releasing the nucleic acid into the cell. One of the most widely
known lipid vectors is lipofectamine. Lipofectamine is a commercially available vector
that has been shown to transfect many different types of stem cells [47]. Lipofectamine has
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also been shown to be a versatile vector being incorporated into several different 3D
scaffolds [47]. These lipid vectors make for an attractive option as they are versatile, have
a wide range of sizes, a high DNA loading capacity, and can be stored stably [47].
However, due to their cytotoxicity, low intracellular stability, low half-life, and rapid
clearance they get seldom use in orthopedic applications [47].
Polymeric vectors form the third type of non-viral vectors. These cationic vectors
are widely used as they can easily interact with anionic DNA and RNA molecules. These
vectors are exceptionally diverse as they can come in either synthetic or natural forms
depending on the application. They are easily incorporated into biomaterials, but there are
some concerns with cytotoxicity and immunology [47].
For synthetic polymer vectors, polyethyleneimine (PEI) is one of the most popular,
being first successfully used in 1995 [72]. It has been used for in vivo transfection in both
cranial and long bones, allowing it to be used in a wide range of bone healing applications
[73, 74]. Despite its large success, PEI is cytotoxic which can affect stem cell
differentiation, slowing the healing process [75,76]. That being said, modifications to PEI
can be made to decrease the cytotoxicity as well as improve its transfection efficiency,
delivery, and cell targeting [47,77, 78,79].
For natural polymeric vectors, collagen and chitosan are often seen as front runners
because of their biocompatibility, cytocompatibility, and ability to be incorporated into 3D
scaffolds [80]. Collagen, and modified versions of it, have been studied extensively for
genetic material transfer applications. It is a particularly valuable delivery method in
orthopedic applications as collagen is one of the primary materials of bone, and has shown
its ability to deliver plasmid parathyroid hormone (PTH) to promote healing of a critical23

sized defect in a tibia [49]. Chitosan is a biodegradable and biocompatible molecule that
contains a cationic region allowing it to form nanoparticle complexes with anionic genetic
cargos [47]. Chitosan has also successfully demonstrated similar transfections rates to both
lipid and synthetic polymeric vectors while showing its ability to deliver molecules to
enhance bone regeneration in vivo [47, 55].
The final category of non-viral vectors includes protein/peptide vectors. These
vectors utilize basic amino acid residues such as lysine or arginine to bind to anionic
genetic cargo and form nanoparticle complexes [65]. These vectors are advantageous due
to their low toxicity, biodegradability, high stability, and high binding capacity [47].
However, they have seen seldom use in vivo and their applications still need further
research.
One of the most revolutionary peptide vectors is GALA. GALA contains repeating
units of glutamic acid, alanine, and leucine which allows it to form an amphipathic α-helix
at lower pHs [81]. However, due to its naturally occurring anionic state, it can deliver
nucleic acids but not condense and protect them [65]. Since the discovery of GALA,
several synthetic peptide vectors have been created to improve upon its delivery
capabilities. Two examples of this are KALA and RALA. KALA was first synthesized by
replacing the glutamic acid residue of GALA with lysine [82]. This amino acid change
allowed for the peptide vector to successfully condense and protect genetic cargo while
delivering it [82]. However, KALA is toxic in a wide range of pH environments [65]. To
that end, the RALA peptide was designed to decrease cytotoxicity while retaining pH
sensitivity and improving both membrane and nucleic acid binding [65]. The RALA
peptide vector was able to demonstrate its ability to form nanoparticles with genetic cargos,
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as well as deliver them intracellularly via endosomal vehicles both in vitro and in vivo [65].
The overall transfection efficacy of RALA is comparable to commercially available vectors
while maintaining lower toxicity [65]. However, RALA has never been tested for nucleic
acid delivery for bone regeneration in vivo before and more research needs to be done.

Figure 1.4: The RALA nanoparticle complex, containing the genetic cargo, leaves
the scaffold and is taken up into the cell via endocytosis. The lower pH inside the
endosome then causes a conformational change in the RALA peptide. This change
allows the peptide to fuse with the endosomal membrane and cleaves the genetic
cargo releasing it into the cytoplasm where it is loaded into the RNA-induced
silencing complex.
1.7 Summary
In summary, large bone defects can often result in non-union healing. While the
current gold standard is autografts and allografts, they are not always a viable option.
Current biomaterial alternatives assist with stability and regeneration, but still have room
for improvement. Protein therapy also offers a unique approach to aiding bone regeneration
but comes with a vast amount of side effects. Gene and RNA therapies offer a promising
approach to bone regeneration, but further research still needs to be conducted. That being
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said, bone regeneration through the delivery of microRNAs on an osteoconductive scaffold
has the potential to greatly improve the lives of patients.
1.8 Hypothesis and Aims
Central Hypothesis: The combination of miR-26a and antagomiR-133a delivered via the
RALA vector incorporated into a collagen-hydroxyapatite scaffold has the potential to
offer a novel and unique tool to additively enhance bone formation since both molecules
have been shown to be osteoanabolic. Therefore, the implantation of the scaffold soakloaded with both miR-26a and antaomiR-133a should regenerate more bone than the
scaffold alone.
Task: Collagen-Hydroxyapatite scaffolds soak-loaded with RALA nanoparticles
containing miR-26a and antagomiR-133a will be implanted into a 7-mm unilateral calvarial
defect in Wistar rats. The following outcomes will be assessed:
a) Qualitatively assess bone formation using micro-computed tomography and
histomorphometry.
b) Quantify the volume of new bone using micro-computed tomography.
c) Quantify tissue mineral density of new bone using micro-computed tomography.
d) Quantify new bone area using histomorphometry.
e) Assess defect width using histomorphometry.
f) Qualitatively assess bone microenvironment histologically.

26

1.9 References
[1] Food and Drug Administration Guidance Document for Industry and CDRH Staff for
the Preparation of Investigational Device Exemptions and Premarket Approval
Applications for Bone Growth Stimulator Devices; Draft; Availability. United Stated:
Office of the Federal Register, National Archives and Records Administration. 1998. p. 63.
23292-3 FR 23292.
[2] Office of the Surgeon General (US). Bone Health and Osteoporosis: A Report of the
Surgeon General. Office of the Surgeon General (US), 2004.
[3] Tzioupis, Christopher, and Peter V Giannoudis. “Prevalence of long-bone non-unions.”
Injury vol. 38 Suppl 2 (2007): S3-9.
[4] Patil, S, and R Montgomery. “Management of complex tibial and femoral nonunion
using the Ilizarov technique, and its cost implications.” The Journal of bone and joint
surgery. British volume vol. 88,7 (2006): 928-32
[5] Ai-Aql, Z S et al. “Molecular mechanisms controlling bone formation during fracture
healing and distraction osteogenesis.” Journal of dental research vol. 87,2 (2008): 107-18.
[6] Eming, Sabine A et al. “Inflammation in wound repair: molecular and cellular
mechanisms.” The Journal of investigative dermatology vol. 127,3 (2007): 514-25.
[7] Wang, Dan et al. “Calvarial Versus Long Bone: Implications for Tailoring Skeletal
Tissue Engineering.” Tissue engineering. Part B, Reviews vol. 26,1 (2020): 46-63.
[8] Long, Fanxin, and David M Ornitz. “Development of the endochondral skeleton.” Cold
Spring Harbor perspectives in biology vol. 5,1 a008334. 1 Jan. 2013,
[9] Bragdon, Beth et al. “Earliest phases of chondrogenesis are dependent upon
angiogenesis during ectopic bone formation in mice.” Bone vol. 101 (2017): 49-61.
[10] Xiao, Zhi-Feng et al. “Cartilage degradation in osteoarthritis: A process of
osteochondral remodeling resembles the endochondral ossification in growth plate?.”
Medical hypotheses vol. 121 (2018): 183-187
[11] Hu, Diane P et al. “Cartilage to bone transformation during fracture healing is
coordinated by the invading vasculature and induction of the core pluripotency genes.”
Development (Cambridge, England) vol. 144,2 (2017): 221-234.
[12] Wehrhan, Falk et al. “Critical size defect regeneration using PEG-mediated BMP-2
gene delivery and the use of cell occlusive barrier membranes - the osteopromotive
principle revisited.” Clinical oral implants research vol. 24,8 (2013): 910-20.
[13] Shibata, Shunichi et al. “An in situ hybridization study of Runx2, Osterix, and Sox9
at the onset of condylar cartilage formation in fetal mouse mandible.” Journal of anatomy
vol. 208,2 (2006): 169-77.

27

[14] Fayaz, Hangama C et al. “The role of stem cells in fracture healing and nonunion.”
International orthopaedics vol. 35,11 (2011): 1587-97.
[15] Wang, Dan et al. “Accelerated calvarial healing in mice lacking Toll-like receptor 4.”
PloS one vol. 7,10 (2012): e46945.
[16] Stewart, S K. “Fracture Non-Union: A Review of Clinical Challenges and Future
Research Needs.” Malaysian orthopaedic journal vol. 13,2 (2019): 1-10.
[17] Mills, Leanora A et al. “The risk of non-union per fracture: current myths and revised
figures from a population of over 4 million adults.” Acta orthopaedica vol. 88,4 (2017):
434-439.
[18] Scolaro, John A et al. “Cigarette smoking increases complications following fracture:
a systematic review.” The Journal of bone and joint surgery. American volume vol. 96,8
(2014): 674-81.
[19] Fahad, S et al. “Infected Non-union of Tibia Treated with Ilizarov External Fixator:
Our Experience.” Malaysian orthopaedic journal vol. 13,1 (2019): 36-41.
[20] Yun, Heather C et al. “Osteomyelitis in military personnel wounded in Iraq and
Afghanistan.” The Journal of trauma vol. 64,2 Suppl (2008): S163-8; discussion S168.
[21] Qu, Huayi et al. “Reconstruction of segmental bone defect of long bones after tumor
resection by devitalized tumor-bearing bone.” World J Surg Onc 13, 282 (2015)
[22] Lewandrowski, K U et al. “Bioresorbable bone graft substitutes of different
osteoconductivities: a histologic evaluation of osteointegration of poly(propylene glycolco-fumaric acid)-based cement implants in rats.” Biomaterials vol. 21,8 (2000): 757-64.
[23] Bauer, T W, and G F Muschler. “Bone graft materials. An overview of the basic
science.” Clinical orthopaedics and related research ,371 (2000): 10-27.
[24] Doi, K et al. “Bone grafts with microvascular anastomoses of vascular pedicles: an
experimental study in dogs.” The Journal of bone and joint surgery. American volume vol.
59,6 (1977): 809-15.
[25] Dimitriou, Rozalia et al. “Complications following autologous bone graft harvesting
from the iliac crest and using the RIA: a systematic review.” Injury vol. 42 Suppl 2 (2011):
S3-15.
[26] Myeroff, Chad, and Michael Archdeacon. “Autogenous bone graft: donor sites and
techniques.” The Journal of bone and joint surgery. American volume vol. 93,23 (2011):
2227-36.
[27] Campana, V et al. “Bone substitutes in orthopaedic surgery: from basic science to
clinical practice.” Journal of materials science. Materials in medicine vol. 25,10 (2014):
2445-61.

28

[28] Manyalich, M et al. “European quality system for tissue banking.” Transplantation
proceedings vol. 41,6 (2009): 2035-43.
[29] Charalambides, Charalambos et al. “Poor results after augmenting autograft with
xenograft (Surgibone) in hip revision surgery: a report of 27 cases.” Acta orthopaedica vol.
76,4 (2005): 544-9
[30] Lerner, Thomas et al. “A level-1 pilot study to evaluate of ultraporous beta-tricalcium
phosphate as a graft extender in the posterior correction of adolescent idiopathic scoliosis.”
European spine journal : official publication of the European Spine Society, the European
Spinal Deformity Society, and the European Section of the Cervical Spine Research
Society vol. 18,2 (2009): 170-9.
[31] Fernandez de Grado, Gabriel et al. “Bone substitutes: a review of their characteristics,
clinical use, and perspectives for large bone defects management.” Journal of tissue
engineering vol. 9 2041731418776819. 4 Jun. 2018
[32] Afifi, Ahmed M et al. “Calcium phosphate cements in skull reconstruction: a metaanalysis.” Plastic and reconstructive surgery vol. 126,4 (2010): 1300-1309.
[33] Pişkin, Erhan et al. “In vivo performance of simvastatin-loaded electrospun spiralwound polycaprolactone scaffolds in reconstruction of cranial bone defects in the rat
model.” Journal of biomedical materials research. Part A vol. 90,4 (2009): 1137-51.
[34] Handoll, H H G, and A C Watts. “Bone grafts and bone substitutes for treating distal
radial fractures in adults.” The Cochrane database of systematic reviews ,2 CD006836. 16
Apr. 2008
[35] Carson, Joshua S, and Mathias P G Bostrom. “Synthetic bone scaffolds and fracture
repair.” Injury vol. 38 Suppl 1 (2007): S33-7.
[36] Xie, Jianwei et al. “Osteoblasts respond to hydroxyapatite surfaces with immediate
changes in gene expression.” Journal of biomedical materials research. Part A vol. 71,1
(2004): 108-17.
[37] Scabbia, Alessandro, and Leonardo Trombelli. “A comparative study on the use of a
HA/collagen/chondroitin sulphate biomaterial (Biostite) and a bovine-derived HA
xenograft (Bio-Oss) in the treatment of deep intra-osseous defects.” Journal of clinical
periodontology vol. 31,5 (2004): 348-55
[38] Yamauchi, Kiyoshi et al. “Preparation of collagen/calcium phosphate multilayer sheet
using enzymatic mineralization.” Biomaterials vol. 25,24 (2004): 5481-9.
[39] O'Loughlin, Padhraig F et al. “Selection and development of preclinical models in
fracture-healing research.” The Journal of bone and joint surgery. American volume vol.
90 Suppl 1 (2008): 79-84.

29

[40] Mehta, Manav et al. “Influence of gender and fixation stability on bone defect healing
in middle-aged rats: a pilot study.” Clinical orthopaedics and related research vol. 469,11
(2011): 3102-10.
[41] Inoue, Satoshi et al. “Repair processes of flat bones formed via intramembranous
versus endochondral ossification.” Journal of Oral Biosciences vol. 62,1 (2020): 52-57.
[42] Spicer, Patrick P et al. “Evaluation of bone regeneration using the rat critical size
calvarial defect.” Nature protocols vol. 7,10 (2012): 1918-29.
[43] Uhthoff, Hans K et al. “Internal plate fixation of fractures: short history and recent
developments.” Journal of orthopaedic science : official journal of the Japanese
Orthopaedic Association vol. 11,2 (2006): 118-26.
[44] Dwek, Jerry R. “The periosteum: what is it, where is it, and what mimics it in its
absence?.” Skeletal radiology vol. 39,4 (2010): 319-23.
[45] Kokubu, Takeshi et al. “Development of an atrophic nonunion model and comparison
to a closed healing fracture in rat femur.” Journal of orthopaedic research : official
publication of the Orthopaedic Research Society vol. 21,3 (2003): 503-10.
[46] Shapiro, Galina et al. “Recent Advances and Future of Gene Therapy for Bone
Regeneration.” Current osteoporosis reports vol. 16,4 (2018): 504-11.
[47] Gonzalez-Fernandez, Tomas et al. “Controlled Non‐Viral Gene Delivery in Cartilage
and Bone Repair: Current Strategies and Future Directions.” Advanced Therapeutics vol.
1,7 (2018): 1800038
[48] Shakir, Sameer et al. “Transforming growth factor beta 1 augments calvarial defect
healing and promotes suture regeneration.” Tissue engineering. Part A vol. 21,5-6 (2015):
939-47.
[49] Bonadio, J et al. “Localized, direct plasmid gene delivery in vivo: prolonged therapy
results in reproducible tissue regeneration.” Nature medicine vol. 5,7 (1999): 753-9.
[50] Clark, Elizabeth A et al. “Concise review: MicroRNA function in multipotent
mesenchymal stromal cells.” Stem cells (Dayton, Ohio) vol. 32,5 (2014): 1074-82.
[51] Montero, A et al. “Disruption of the fibroblast growth factor-2 gene results in
decreased bone mass and bone formation.” The Journal of clinical investigation vol. 105,8
(2000): 1085-93.
[52] Ratko, Thomas A, et al. Bone Morphogenetic Protein: The State of the Evidence of
On-Label and Off-Label Use. Agency for Healthcare Research and Quality (US), 6 August
2010.
[53] Raftery, Rosanne M et al. “Delivery of the improved BMP-2-Advanced plasmid DNA
within a gene-activated scaffold accelerates mesenchymal stem cell osteogenesis and
critical size defect repair.” Journal of controlled release vol. 283 (2018): 20-31.
30

[54] Sheridan, Cormac. “Gene therapy finds its niche.” Nature biotechnology vol. 29,2
(2011): 121-8.
[55] Raftery, Rosanne M et al. “Translating the role of osteogenic-angiogenic coupling in
bone formation: Highly efficient chitosan-pDNA activated scaffolds can accelerate bone
regeneration in critical-sized bone defects.” Biomaterials vol. 149 (2017): 116-127
[56] Marzi, Matteo J et al. “Degradation dynamics of microRNAs revealed by a novel
pulse-chase approach" Genome Res. vol. 26,4 (2016): 554-65
[57] Vaughan, Erin E et al. “Intracellular trafficking of plasmids for gene therapy:
mechanisms of cytoplasmic movement and nuclear import.” Current gene therapy vol. 6,6
(2006): 671-681.
[58] Sun, Liang et al. “MiR-26a promotes fracture healing of nonunion rats possibly by
targeting SOSTDC1 and further activating Wnt/β-catenin signaling pathway.” Molecular
and cellular biochemistry vol. 460,1-2 (2019): 165-173.
[59] Cho, Sung-Won et al. “Interactions between Shh, Sostdc1 and Wnt signaling and a
new feedback loop for spatial patterning of the teeth.” Development vol. 138,9 (2011):
1807-16.
[60] Zhang, Xiaojin et al. “Cell-free 3D scaffold with two-stage delivery of miRNA-26a to
regenerate critical-sized bone defects.” Nature Communications 7 (2016): 10376
[61] Liu, Zhi et al. “Lentivirus-mediated microRNA-26a overexpression in bone
mesenchymal stem cells facilitates bone regeneration in bone defects of calvaria in mice.”
Molecular medicine reports vol. 18,6 (2018): 5317-5326.
[62] Li, Zhaoyong et al. “A microRNA signature for a BMP2-induced osteoblast lineage
commitment program.” Proceedings of the National Academy of Sciences of the United
States of America vol. 105,37 (2008): 13906-11.
[63] Mencía Castaño, Irene et al. “Next generation bone tissue engineering: non-viral miR133a inhibition using collagen-nanohydroxyapatite scaffolds rapidly enhances
osteogenesis.” Scientific reports vol. 6 (2016): 27941
[64] Castaño, Irene Mencía et al. “Rapid bone repair with the recruitment of CD206+M2like macrophages using non-viral scaffold-mediated miR-133a inhibition of host cells.”
Acta biomaterialia vol. 109 (2020): 267-279.
[65] McCarthy, Helen O et al. “Development and characterization of self-assembling
nanoparticles using a bio-inspired amphipathic peptide for gene delivery.” Journal of
controlled release vol. 189 (2014): 141-9.
[66] Yin, Hao et al. “Non-viral vectors for gene-based therapy.” Nature reviews. Genetics
vol. 15,8 (2014): 541-55.

31

[67] Williams, David A, and Adrian J Thrasher. “Concise review: lessons learned from
clinical trials of gene therapy in monogenic immunodeficiency diseases.” Stem cells
translational medicine vol. 3,5 (2014): 636-42.
[68] Dizaj, Solmaz Maleki et al. “A sight on the current nanoparticle-based gene delivery
vectors.” Nanoscale research letters vol. 9,1 (2014): 252.
[69] Riley, Michael K, and Wilfred Vermerris. “Recent Advances in Nanomaterials for
Gene Delivery-A Review.” Nanomaterials vol. 7,5 (2017): 94.
[70] Yu, Meng et al. “Optimizing surface-engineered ultra-small gold nanoparticles for
highly efficient miRNA delivery to enhance osteogenic differentiation of bone
mesenchymal stromal cells.” Nano Res. 10, (2017): 49–63.
[71] Plank, Christian et al. “Magnetically enhanced nucleic acid delivery. Ten years of
magnetofection-progress and prospects.” Advanced drug delivery reviews vol. 63,14-15
(2011): 1300-31.
[72] Boussif, O et al. “A versatile vector for gene and oligonucleotide transfer into cells in
culture and in vivo: polyethylenimine.” Proceedings of the National Academy of Sciences
of the United States of America vol. 92,16 (1995): 7297-301.
[73] Curtin, Caroline M et al. “Combinatorial gene therapy accelerates bone regeneration:
non-viral dual delivery of VEGF and BMP2 in a collagen-nanohydroxyapatite scaffold.”
Advanced healthcare materials vol. 4,2 (2015): 223-7.
[74] Li, Jingtang et al. “Study of PLGA microspheres loaded with pOsx/PEI nanoparticles
for repairing bone defects in vivo and in vitro.” Advances in clinical and experimental
medicine vol. 29,4 (2020): 431-440.
[75] Parhamifar, Ladan et al. “Polycation cytoxicity: a delicate matter for nucleic acid
therapy-focus on polyethyleneimine.” Soft Matter vol. 6,17 (2010): 4001-09.
[76] Gonzalez-Fernandez, T et al. “Mesenchymal stem cell fate following non-viral gene
transfection strongly depends on the choice of delivery vector.” Acta biomaterialia vol. 55
(2017): 226-238.
[77] Thomas, Mini et al. “Identification of novel superior polycationic vectors for gene
delivery by high-throughput synthesis and screening of a combinatorial library.”
Pharmaceutical research vol. 24,8 (2007): 1564-71.
[78] Türk, M et al. “Smart and cationic poly(NIPA)/PEI block copolymers as non-viral
vectors: in vitro and in vivo transfection studies.” Journal of tissue engineering and
regenerative medicine vol. 1,5 (2007): 377-88.
[79] Pi, Yanbin et al. “Targeted delivery of non-viral vectors to cartilage in vivo using a
chondrocyte-homing peptide identified by phage display.” Biomaterials vol. 32,26 (2011):
6324-32.
32

[80] Dang, Jiyoung M, and Kam W Leong. “Natural polymers for gene delivery and tissue
engineering.” Advanced drug delivery reviews vol. 58,4 (2006): 487-99.
[81] Li, Weijun et al. “GALA: a designed synthetic pH-responsive amphipathic peptide
with applications in drug and gene delivery.” Advanced drug delivery reviews vol. 56,7
(2004): 967-85.
[82] Wyman, T B et al. “Design, synthesis, and characterization of a cationic peptide that
binds to nucleic acids and permeabilizes bilayers.” Biochemistry vol. 36,10 (1997): 300817.
[83] Mabilleau, Guillaume et al. “Effects of FGF-2 release from a hydrogel polymer on
bone mass and microarchitecture.” Biomaterials vol. 29,11 (2008): 1593-600.
[84] Gronowicz, Gloria et al. “* Calvarial Bone Regeneration Is Enhanced by Sequential
Delivery of FGF-2 and BMP-2 from Layer-by-Layer Coatings with a Biomimetic Calcium
Phosphate Barrier Layer.” Tissue engineering. Part A vol. 23,23-24 (2017): 1490-1501.
[85] Leach, J Kent et al. “Coating of VEGF-releasing scaffolds with bioactive glass for
angiogenesis and bone regeneration.” Biomaterials vol. 27,17 (2006): 3249-55.
[86] Walsh, David P et al. “Rapid healing of a critical-sized bone defect using a collagenhydroxyapatite scaffold to facilitate low dose, combinatorial growth factor delivery.”
Journal of tissue engineering and regenerative medicine vol. 13,10 (2019): 1843-1853.
[87] Govender, Shunmugam et al. “Recombinant human bone morphogenetic protein-2 for
treatment of open tibial fractures: a prospective, controlled, randomized study of four
hundred and fifty patients.” The Journal of bone and joint surgery. American volume vol.
84,12 (2002): 2123-34.
[88] Friedlaender, G E et al. “Osteogenic protein-1 (bone morphogenetic protein-7) in the
treatment of tibial nonunions.” The Journal of bone and joint surgery. American volume
vol. 83-A Suppl 1,Pt 2 (2001): S151-8.
[89] Poon, Bonnie et al. “Bone morphogenetic protein-2 and bone therapy: successes and
pitfalls.” The Journal of pharmacy and pharmacology vol. 68,2 (2016): 139-47.
[90] Carragee, Eugene J et al. “A critical review of recombinant human bone
morphogenetic protein-2 trials in spinal surgery: emerging safety concerns and lessons
learned.” The spine journal vol. 11,6 (2011): 471-91.
[91] Mesfin, Addisu et al. “High-dose rhBMP-2 for adults: major and minor complications:
a study of 502 spine cases.” The Journal of bone and joint surgery. American volume vol.
95,17 (2013): 1546-53.
[92] Casap, Nardy et al. “Recombinant human bone morphogenetic protein-2 confined by
an imperforate titanium shell over high-profile dental implants in rabbit tibiae: a pilot bone
augmentation study.” The International journal of oral & maxillofacial implants vol. 28,6
(2013): e349-56.
33

[93] Clarke, Bart. “Normal bone anatomy and physiology.” Clinical journal of the
American Society of Nephrology : CJASN vol. 3 Suppl 3,Suppl 3 (2008): S131-9.
[94] Marsell, Richard, and Thomas A Einhorn. “The biology of fracture healing.” Injury
vol. 42,6 (2011): 551-5.
[95] Schmitz, J P, and J O Hollinger. “The critical size defect as an experimental model for
craniomandibulofacial nonunions.” Clinical orthopaedics and related research ,205 (1986):
299-308.
[96] Vajgel, André et al. “A systematic review on the critical size defect model.” Clinical
oral implants research vol. 25,8 (2014): 879-93.
[97] Sato, Kenji et al. “Establishment of reproducible, critical-sized, femoral segmental
bone defects in rats.” Tissue engineering. Part C, Methods vol. 20,12 (2014): 1037-41.
[98] Sheen, Jonathon R. and Vishnu V. Garla. “Fracture Healing Overview.” StatPearls,
StatPearls Publishing, 27 October 2020.
[99] Kumar C, Yashavantha et al. “Calcium sulfate as bone graft substitute in the treatment
of osseous bone defects, a prospective study.” Journal of clinical and diagnostic research :
JCDR vol. 7,12 (2013): 2926-8.
[100] Kolk, Andreas et al. “Comparative analysis of bone regeneration behavior using
recombinant human BMP-2 versus plasmid DNA of BMP-2.” Journal of biomedical
materials research. Part A vol. 107,1 (2019): 163-173.
[101] Rüedi P, Thomas and Murphy M, W. AO Principles of Fracture Management.
Stuttgart ; New York : Thieme ; Davos Platz [Switzerland] : AO Pub., 2000.
[102] Lawson, A C, and J T Czernuszka. “Collagen--calcium phosphate composites.”
Proceedings of the Institution of Mechanical Engineers. Part H, Journal of engineering in
medicine vol. 212,6 (1998): 413-25.
[103] Grimal, Q, and Laugier P. “Quantitative ultrasound assessment of cortical bone
properties beyond bone mineral density” IRBM vol. 40,1 (2019): 16-24.
[104] Cooper, D M L et al. “Comparison of Microcomputed Tomographic and
Microradiographic Measurements of Cortical Bone Porosity” Calcified Tissue
International vol. 74 (2004): 437-447.
[105] Renders, G A P et al. “Porosity of human mandibular condylar bone.” Journal of
anatomy vol. 210,3 (2007): 239-48.
[106] Lillie, Elizabeth M et al. “Estimation of skull table thickness with clinical CT and
validation with microCT.” Journal of anatomy vol. 226,1 (2015): 73-80.
[107] Mariner, Peter et al. “Synthetic Hydrogel Scaffold Is an Effective Vehicle for
delivery of INFUSE (rhBMP2) to Critical-Sized Calvaria Bone Defects in Rats.” Journal
of Orthopedic Research vol. 31(2013): 401-406.
34

[108] Loi, Florence et al. “Inflammation, fracture and bone repair.” Bone vol. 86 (2016):
119-30

35

CHAPTER 2
MIR-26A PILOT STUDY
2.1 Introduction
Bone fractures occur due to a wide variety of injuries such as trauma or tumor
removal. It is estimated that 5-10% of these bone fractures fail to heal properly resulting in
either delayed healing or non-union [1]. The current gold standard for treating these injuries
is autografts and allografts. However due to limitations such as fracture size or availability
these treatments are not always available. Some alternatives to bone grafting involve the
use of protein therapy such as Medtronic’s INFUSE. These alternatives deliver protein
BMP-2 on a collagen sponge and are often used for spinal fusions. However, protein
therapies such as this have the potential to have negative side effects such as
carcinogenicity and infection [2].
Recent research has developed a novel collagen-hydroxyapatite scaffold that is
stronger and more osteoconductive than collagen sponges [3]. These scaffolds contain a
porous architecture that allows cells to uptake and deliver therapeutic agents. This allows
them to be used in combination with other protein therapy alternatives.
One protein therapy alternative that has been brought into the spotlight as of
recently is the use of microRNAs (miRNA). These RNA molecules are small, non-coding,
and serve as repressors of gene expression across a large variety of biological activities [4].
Their functions can be upregulated by delivering endogenous miRNAs to the cells within
the body. One miRNA that is of particular interest is miR-26a which is thought to be
involved in osteoblast's ability to differentiate [5]. Delivery of miR-26a via polymers has
been shown to increase bone volume and bone mineral density in in vivo calvarial defects
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[6]. While these are encouraging results, there is still room to increase the effectiveness of
these treatments.
MicroRNAs are often delivered using vectors as there has been little success using
direct delivery [7]. Oftentimes, viral vectors are used due to their high transfection rates,
high transgene expression levels, and persistent gene expression [8]. Unfortunately, they
have limited nucleic acid loading capacity and are expensive to produce in high quantities
[9]. Due to these limitations, there has been an increased demand for non-viral delivery
systems. One of these is the 30 amino acid peptide vector RALA. RALA can spontaneously
form nanoparticles with miRNAs while being non-toxic [8]. In addition to this,
collaborators have shown that RALA-miR-26a nanoparticles can be successfully soakloaded into collagen-hydroxyapatite scaffolds making them ideal candidates for delivery.
The combination of collagen-hydroxyapatite, RALA, and miR-26a as an
implantable alternative to bone grafting shows promise but has yet to be explored in vivo.
This pilot study aims to set the foundation for the use of this multitiered implantable system
in vivo. It addresses these aims by allowing our lab to familiarize ourselves with the
calvarial defect model, while also testing the in vivo reaction to the implantation of this
system, as well as its healing efficacy through micro-computed tomography. For all
therapeutics, the duration of the therapeutic at the healing site is important to know to
evaluate effects. This can be explored in vitro by testing release profiles, but often does not
completely represent the in vivo response. Nanoparticles can be fluorescently labeled and
imaged in vivo to quantify their duration at the wound site once implant. To test this, the
fluorescent label Cy5 will be explored to track the nanoparticles in vivo.
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2.2 Methods
2.2.1 Animals
For the calvarial defect portion of the study, twelve Male Sprague Dawley CD Rats
were used. At the beginning of the study, animals were approximately 11 weeks old and
weighed 340-380g. The animals were housed, one to a cage, in autoclaved, plastic cages
labeled with cards. The cages were kept in the temperature-controlled University of
Massachusetts Amherst animal care facility. Throughout the entire experiment, animals
had ad libitum access to food and water, as well as a standard day/night cycle. All housing
and in vivo experimental procedures were performed in accordance with protocol #1859
approved by the Institutional Animal Care and Use Committee (IACUC) of the University
of Massachusetts Amherst.
For subcutaneous implants, three Male Sprague Dawley CD Rats were used. At the
beginning of the study, animals were 12 weeks and weighed 375-420g. The animals were
housed, four to a cage, with rats from another study, in autoclaved, plastic cages labeled
with cage cards. The cages were kept in the temperature-controlled University of
Massachusetts Amherst animal care facility. Throughout the entire experiment, animals
had ad libitum access to food and water, as well as a standard day/night cycle. All housing
and in vivo experimental procedures were performed in accordance with protocol #2364
approved by the Institutional Animal Care and Use Committee (IACUC) of the University
of Massachusetts Amherst.
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2.2.2 Nanoparticle Preparation
The nanoparticle complexes were prepared by collaborators at Queen’s University
Belfast, Belfast, Northern Ireland. Negatively charged miR-26a was incubated with
positively charged RALA peptides for 30 minutes at room temperature to allow
nanoparticles to form via electrostatic interaction. Nanoparticles were lyophilized prior to
shipment and rehydrated with pure water before use. All nanoparticle complexes were
prepared with an N:P (the molar ratio of positively charged nitrogen atoms in the peptide
to negatively charged phosphates in the miRNA) of 8.
2.2.3 Scaffold Preparation
Scaffolds were prepared by collaborators at Royals College of Surgeons, Dublin,
Ireland, as previously described using a freeze-drying technique [3]. Scaffolds were cut
into discs with an 8mm diameter and a 2mm height. Scaffolds were rehydrated and shaken
overnight in 2 ml DPBS per scaffold. They were then chemically crosslinked twice for 2
hours using 0.77 mg 1-(3-Dimethylaminopropyl)-3-ethylcarbodiimide hydrochloride
(EDAC) and 0.18 mg N-hydroxysuccinimide (NHS) dissolved in 2 ml pure water per
scaffold. In between crosslinks, the excess EDAC and NHS mixture was washed off using
2 ml DPBS per scaffold. After the final wash, scaffolds were stored in DPBS for no longer
than 7 days before use. The collagen-hydroxyapatite scaffolds were then soak-loaded with
20 µl of nanoparticle solution or pure water.
2.2.4 Calvarial Defect Experimental Design
The twelve animals were randomly divided evenly into 4 treatment groups. Each
group received a collagen-hydroxyapatite scaffold soak-loaded with one of four treatments
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(A) 0.3 µg miR-26a; (B) 1.0 µg miR-26a; (C) 3.0 µg miR-26a; (D) pure water (Scaffold
Only). All microRNAs were delivered as RALA nanoparticle complexes. Within each
microRNA group, each rat received a different concentration of Cy5 attached to the miR26a (A) .75 µL Cy5/µg miR-26a; (B) 1.0 µL Cy5/µg miR-26a; (C) 1.25 µL Cy5/µg miR26a. This was done to image the nanoparticles in vivo. Each rat’s final treatment can be
seen in table 2.1. Due to the training nature of the pilot study, rats 1 and 2 died during
surgery and rat 6 only survived until the week 4 time point.
Rat (Ear Tag ID)

Treatment

Cy5 Dose

1 (52)

Scaffold Only

N/A

2 (54)

Scaffold Only

N/A

3 (55)

Scaffold Only

N/A

4 (56)

1.0 µg miR-26a

1.0 µL Cy5/µg miR-26a

5 (57)

0.3 µg miR-26a

1.0 µL Cy5/µg miR-26a

6 (58)

3.0 µg miR-26a

1.0 µL Cy5/µg miR-26a

7 (59)

1.0 µg miR-26a

0.75 µL Cy5/µg miR-26a

8 (60)

3.0 µg miR-26a

0.75 µL Cy5/µg miR-26a

9 (61)

0.3 µg miR-26a

1.25 µL Cy5/µg miR-26a

10 (62)

0.3 µg miR-26a

0.75 µL Cy5/µg miR-26a

11 (63)

3.0 µg miR-26a

1.25 µL Cy5/µg miR-26a

12 (64)

1.0 µg miR-26a

1.25 µL Cy5/µg miR-26a

Table 2.1: A summary of each treatment and Cy5 concentration received by each
rat.
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2.2.5 Calvarial Defect Surgical Procedure
Surgical guidelines were based on previously published protocols [10]. Animals
were weighed and subcutaneously injected with buprenorphine hydrochloride (.05mg/kg)
as a preemptive analgesic at least 30 minutes before surgery. Animals were then
anesthetized using via isoflurane inhalation (2.5%-3.5%) to effect. Appropriate depth of
anesthesia was determined by breathing rate and lack of eye blink, tail pinch, and toe pinch
reflexes. Animals were then subcutaneously injected with cefazolin (20mg/kg) as a
prophylactic antibiotic and sterile saline (5mL/kg) to account for fluid losses during
surgery. Animals’ ears were pierced with an ear tag identifier. The incision site was shaved
and disinfected with Isopropyl Alcohol and Chlorohexidine. Animals were then moved to
the surgical table and placed on a sterile drape on top of a warming therapy pad (38°C) for
thermal support. A fenestrated drape was then placed over the animal. During surgery,
anesthesia was maintained via a nose cone, and depth was assessed using breathing rate
and lack of eye blink, tail pinch, and toe pinch reflexes.
All surgical procedures were self-performed using aseptic techniques, conditions,
and equipment. Throughout the entire procedure, gauze and sterile saline irrigation were
used to clean the surgical site and manage bleeding. A midline incision was made through
the skin and periosteum along the sagittal suture. The periosteum was laterally contracted
using an elevator to expose the underlying calvaria. A dental drill in combination with a 6mm trephine operating at 1500rpm was used to create a 6-mm midline circular transosseous
defect. Extreme caution was taken not to damage the underlying dura mater. An elevator
and Brown-Adson forceps were used to lift and remove the disk of bone from the defect
area. Soak-loaded scaffolds were then press-fit into the defect region. The periosteum and
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skin were then both closed using 4-0 monofilament absorbable sutures. Wound clip staples
were then placed over the incision, finalizing the surgical procedure.
Animals were left to recover on a heating pad until fully awake. Once awake,
animals were placed back into cages. Animals received subcutaneous injections of
buprenorphine hydrochloride (.05mg/kg) 12-, 24-, and 36-hours post-surgery as a
postoperative analgesic. Animals were monitored for signs of distress daily post-surgery.
No implant rejections or inflammatory reactions were observed in any of the surviving
animals.
2.2.6 Subcutaneous Implant Experimental Design
Three Sprague Dawley rats each received two subcutaneous implants of Cy5/miR26a nanoparticle soak-loaded scaffolds in order to optimize in vivo imaging once it was
found to be undetectable in the calvarial defect model. Each rat received two implants of
1µg of miR-26a with Cy5:miR-26a ratios of 1.5:1 and 2:1 on a collagen-hydroxyapatite
scaffold in a subcutaneous pocket. The 1.5:1 ratio was placed on the left side of all the rats
and the 2:1 on the right side. The biomaterial was then imaged using an IVIS Spectrum in
vivo Imaging System on days 1, 3, 5, 7, 14, 21, and 28 post-surgeries.
2.2.7 Subcutaneous Implant Surgical Procedure
Animals were weighed and subcutaneously injected with buprenorphine
hydrochloride (.05mg/kg) at least 30 minutes before surgery. Animals were then
anesthetized via isoflurane inhalation (2.5%-3.5%) to effect. Appropriate depth of
anesthesia was determined by breathing rate and lack of eye blink, tail pinch, and toe pinch
reflexes. Animals were then subcutaneously injected with cefazolin (20mg/kg) and sterile
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saline (5mL/kg). Animals’ ears were pierced with an ear tag identifier. Animals were then
moved to the surgical table and placed on a sterile drape on top of a warming therapy pad
(38°C). During surgery, anesthesia was maintained via a nose cone, and depth was assessed
using breathing rate and lack of eye blink, tail pinch, and toe pinch reflexes.
All surgical procedures were performed using aseptic techniques, conditions, and
equipment. Two 6-mm incisions were made in the skin, one behind each leg near the hip
area. From the incision, subcutaneous pockets were formed and a single soak-loaded
scaffold was placed inside. The skin was then sutured closed using 4-0 monofilament
absorbable suture.
Animals were left to recover on a heating pad until fully awake. Once awake,
animals were placed back into cages. Animals received subcutaneous injections of
buprenorphine hydrochloride (.05mg/kg) 12-, 24-, and 36-hours post-surgery as a
postoperative analgesic. Animals were monitored for signs of distress daily post-surgery.
No implant rejections or inflammatory reactions were observed in any of the animals.
2.2.8 IVIS Imaging
IVIS imaging of the fluorescently labeled nanoparticles was performed in vivo on
days 3 and 5 for the calvarial implants and 1-, 3-, 5-, 7-, 14-, 21-, and 28-days post-surgery
for the subcutaneous implants. At each time point, rats were placed into chambers and
anesthetized by isoflurane inhalation (2.5%) to effect. Rats were then transferred to the
IVIS systems and imaged at an excitation of 640 nm and an emission of 680 nm. Scaffolds
were also imaged in vitro prior to implantation and post-explant to confirm nanoparticle

43

fluorescence for the subcutaneous study. A circular ROI of 8 mm was used to quantify
average radiant efficiency for the subcutaneous study.
2.2.9 Micro-Computed Tomography
Scans
Micro-Computed Tomography (µCT) was performed in vivo 4-, 8- and 12-weeks
post-surgery. Animals were then anesthetized using via isoflurane inhalation (2.5%-3.5%)
to effect, then placed cylinder sample holder inside the µCT (Bruker Skyscan 1276).
Anesthesia was maintained via nose cone throughout the entire scan. Ear identification tags
were taped away from the region of interest, as to not interfere with scanning. Animals
were scanned with a voxel size of 40 µm and a 1 mm aluminum filter. The x-ray tube
voltage was 60 kV, the current was 125 µA, and the exposure time was 490 ms. Images
were collected every .800º using a 360º rotation around the sample.
Image Reconstruction
Three-dimensional image reconstructions were performed using NRecon (Bruker).
Mis-alignment compensation varied from scan to scan to ensure that images were of the
highest quality. All reconstructions were done with the same dynamic range of 0 to
.052639. A universal beam hardening of 30%, a Gaussian smoothing of 2, and a ring
artifact correction of 10 were used on each set of images. Images were then exported as
TIF Files. Following NRecon reconstruction images, images were imported into
DataViewer. Using DataViewer images were aligned and datasets of coronal planes were
saved. Each animals’ week 4, week 8, and week 12 scans were aligned using DataViewer’s
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3D registration. This was done to ensure that the region of interest was kept in the same
location for all time points.
Analysis
A cylindrical VOI with a diameter of 6mm and variable height that ranged the
height of the bone growth to the bottom of the defect was used for analysis. This was done
to encapsulate all bone formation including ectopic bone that had formed. Using this VOI,
total bone volume and tissue mineral density were quantified. Tissue mineral density is
defined as the average mineral density of the bone excluding surrounding soft tissue. A
variable threshold ranging between 83-255 and 114-255 on a scale of 0-255 was utilized.
This was initially done to threshold the pictures to look as close to their original µCT
picture as possible.
2.2.10 Euthanasia
The rats were anesthetized at 12 weeks using 2.5% to 3.5% isoflurane and
euthanatized via intracardiac exsanguination.
2.2.11 Statistical Analysis
A repeated measures mixed model was used to compare healing efficacy between
groups for µCT data. A value of p <0.05 was considered significant. All graphs are
represented as mean ± 1 SE.
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2.3 Results
2.3.1 Animals
As previously mentioned, three animals from the calvarial defect study were lost
due to complications and removed from the study. No animals were lost during the
subcutaneous implant study. All animals kept in studies exhibited no signs of illness,
infection, or implant rejection. All animals continued to eat, drink, and gain weight
normally throughout the study.
2.3.2 Micro-Computed Tomography
All four groups showed significant bone growth throughout the time course of the study
(p=0.0007). All groups also showed an increase in tissue mineral density throughout the
experiment (p=0.0012). However, there was no significant difference in bone volume
(p=0.47762) or tissue mineral density (p=0.3334) between the groups.

Figure 2.1: Bone Volume at weeks 4, 8, and 12 (p=.47762). Mean ± SE.
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Figure 2.2: Tissue Mineral Density at weeks 4, 8, and 12 (p=.3334). Mean ± SE.

2.3.3 IVIS – Calvarial Defect
Nanoparticles were not detectable at either day 3 or day 5 in any of the samples
for IVIS imaging in the calvarial defect (figure 2.3).

Figure 2.3: IVIS imaging of the rats 3- and 5-days post calvarial defect surgery. No
fluorescence was detected in any of the concentrations at either timepoint.
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2.3.4 IVIS – Subcutaneous Implant
All implanted scaffolds were able to be detected in vitro before implantation. Once
implanted, two of the three 1.5:1 and all of the 2:1 Cy5:miR-26a nanoparticles could not
be detected in vivo through the rats' tissue. A ratio of 2:1 was the highest recommended by
the manufacturer. All imaging of non-detectable samples was discontinued after day 3. The
one scaffold with detectable nanoparticles was still fully visible until day 28 when the study
was terminated. The average radiant efficacy slowly declined between 3 and 14 due to the
growth of the rat's fur and then increased at day 21 after the rat was shaved again.

Figure 2.4: IVIS imaging of the detectable nanoparticles at different time points
post subcutaneous implant. The yellow circle represents the approximate region of
interest.
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Figure 2.5: In vivo fluorescence of the detectable 1.5:1 ratio nanoparticles.
Nanoparticles were detectable between days 1 and 28 when the study was
terminated.
2.4 Discussion
The primary objective of this study was to serve as a pilot study for the evaluation
of microRNA treatments in rat calvaria defects. This involved developing and performing
a calvarial defect procedure that was new to our lab while testing the healing efficacy of
different doses of miR-26a in combination with RALA nanoparticles delivered on a
collage-hydroxyapatite scaffold. This novel multi-tiered system had never been used in
vivo before and it was essential to test its efficacy before moving to a larger-scale
experiment. A secondary objective of this study was to develop a method to be able to
image our RALA nanoparticles in vivo. This was difficult in the calvarial defect model but
was slightly improved upon with the subcutaneous implants.
Throughout the study, bone formation was evaluated at four, eight, and twelve
weeks in vivo using µCT. Signs on bone formation increase throughout the time course of
the study. All treatments groups experienced higher bone formation than would be
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expected of empty defects. All three microRNA doses had greater bone formation than the
scaffold only group by week 12. This does lack significance due to the pilot nature of the
study. However, it does show promising results to move forward with a more formal study.
There was no distinguishable difference between any of the three doses delivered and all
doses would be able to be used in future work. All animals receiving implants showed no
signs of rejection, infection, or illness which again leads into the positive direction of a
large-scale study.
While the nanoparticle could not be successfully and consistently imaged in vivo
there are still several takeaways from this portion of the pilot study. All of the scaffolds
were able to be imaged successfully in vitro demonstrating that the nanoparticles were able
to be labeled with fluorescent dyes and soak-loaded into the scaffolds. One dosage of
nanoparticles was able to be detected for 28 days, signifying that it is possible to detect the
nanoparticles in vivo over long periods in subcutaneous pockets. A dip in the fluorescence
over time followed by an increase also directly correlated with the growth and removal of
the rat’s fur, indicating that is essential to shave the rats before IVIS imaging so that the
autofluorescence of the fur does not interfere with the nanoparticles. Overall, these two
rounds of IVIS images allowed us to see the limitations when using Cy5 as a fluorescence
label and gave the insight that other dyes should be explored. A potential alternative
includes Cy7 as it excites at a higher wavelength than Cy5 and would interfere less with
the rats' autofluorescence.
Overall, this study was successful. A usable protocol for calvarial defects was able
to be carried out by our lab. The soak-loaded collagen-hydroxyapatite scaffolds were able
to be implanted successfully without any negative side effects and were able to regenerate
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bone over 12 weeks. Finally, the use of Cy5 as a in vivo fluorescence label for RALA
nanoparticles was assessed and determined not to be suitable for this application.
2.5 Conclusion
All 3 doses of miR-26a delivered via and RALA nanoparticles and a collagenhydroxyapatite scaffold were able to successfully regenerate bone in a 6-mm calvarial
defect. These results show promise in moving forward to a larger study to evaluate this
novel system to deliver multiple microRNAs. Future studies will also focus on the
optimization of fluorescent labels in order to track the delivery of nanoparticles in vivo.
These future studies will be essential in determining and optimizing the full therapeutic
effects of this novel gene-activated scaffold.
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CHAPTER 3
MIRNA HEALING EFFICACY
3.1 Introduction
Approximately 6 million bone fractures occur in the United States annually [1]. It
is estimated that 5-10% of these fractures result in either delayed or non-union healing [2].
These injuries occur due to a wide variety of reasons, such as trauma, tumor removal,
infection, or developmental deformities. For many years, autografts and allografts have
been the gold standard for treatment for these complications, and are utilized in millions of
orthopedic procedures each year [3]. However, bone grafting is not always a practical
option due to limitations such as availability, defect size, and location. Thus, there is a clear
unmet need for alternative treatments for large bone defects.
One alternative to bone grafting involves the use of biomaterial scaffolds to deliver
cells or bioactive factors. Examples of these include Medtronic’s INFUSE which is a
collagen scaffold that delivers BMP-2 for lumbar vertebral interbody fusion and Stryker’s
OP-1 implant which delivers BMP-7 for tibial non-unions [17]. However, these
applications are limited by poor mechanical properties and adverse effects from protein
therapy [14,18]. Recent work has developed a novel collagen-hydroxyapatite scaffold that
has increased mechanical and osteoconductive properties compared to collagen alone [14].
Collagen-hydroxyapatite scaffolds have also increased bone formation in both small and
large animals as well as several humans [14,15]. Furthermore, their porous architecture
allows them to uptake cells and deliver therapeutic agents [9,14]. As a result, collagenhydroxyapatite scaffolds can be used in unison with therapeutics that promote and enhance
bone repair.
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That being said, one type of therapeutic gaining traction for promoting bone
regeneration is the delivery of nucleic acids such as MicroRNAs (miRNAs). MiRNAs are
small non-coding RNA molecules that generally range from 20-24 nucleotides, serve as
repressors of gene expression, and are involved in a wide range of biological activity [4].
MiRNAs functions can be upregulated or inhibited by delivering either miRNA mimics or
miRNA inhibitors known as antagomiRs [4]. Certain miRNAs have been shown to regulate
osteoblast function, angiogenesis, and other processes that are crucial to bone fracture
healing [6]. Two miRNAs that are of particular interest in this study are miR-26a and miR133a. Studies have demonstrated that miR-26a is involved in osteoblastic differentiation
and has also been shown to increase bone volume and bone mineral density in in vivo bone
defects [6-7]. MiR-133a is believed to be a negative regulator of Runx2, the key
transcription factor of osteogenesis [8]. A recent study showed that the inhibition of miR133a using antagomiR-133a delivered by collagen-hydroxyapatite scaffolds caused an
increase in bone formation in a rat calvarial defect [9]. However, while these are promising
results, there is still potential to increase the effectiveness of these miRNAs.
Nucleic acids, such as miRNAs, are often delivered using vectors, as direct nucleic
acid delivery has yielded minimal success due to off-targeted localization, degradation, and
poor cellular uptake [10]. Viral vectors are common due to their high transfection rates,
high transgene expression levels, and persistent and stable gene expression [11]. However,
they are also associated with toxicity, limited nucleic acid loading capacity,
immunogenicity, and are expensive to produce in high quantities [12]. This has resulted in
an increased desire for more non-viral vectors such as RALA. RALA is a 30 amino acid,
cationic, peptide vector that can spontaneously form nanoparticle complexes with miRNA
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[12]. It is non-toxic and able to deliver genes that promote differentiation of MSCs and
osteogenesis [13]. Additionally, previous studies have shown that RALA vectors can be
readily incorporated into collagen-hydroxyapatite scaffolds making them ideal candidates
for the delivery of our miRNAs.
As previously mentioned, collagen-hydroxyapatite, miR-26a and antagomiR-133a,
have all individually shown promising results for the treatment of large bone defects. While
the RALA peptide vector has never been used to specifically deliver miR-26a or
antagomiR-133a, it also shows promise for the delivery of genetic cargo for orthopedic
applications. Thus, we hypothesize that the combination of miR-26a and antagomiR-133a
delivered via the RALA vector incorporated into a collagen-hydroxyapatite scaffold has
the potential to offer a novel and unique tool to rapidly enhance bone formation. The
objective of this study is to evaluate the efficacy of this multi-tiered novel system for bone
healing using both micro-computed tomography and histology.
3.2 Methods
3.2.1 Animals
Thirty-Two Male Wistar Rats were used in this experiment. At the beginning of the
study, animals were approximately 11 weeks old and weighed between 340-400g. The
animals were housed, two to a cage, in autoclaved, plastic cages labeled with cards. The
cages were kept in the temperature-controlled University of Massachusetts Amherst animal
care facility. Throughout the entire experiment, animals had ad libitum access to food and
water, as well as a standard day/night cycle. All housing and in vivo experimental
procedures were performed in accordance with protocol #2466 approved by the
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Institutional Animal Care and Use Committee (IACUC) of the University of Massachusetts
Amherst.
3.2.2 Nanoparticle Preparation
The nanoparticle complexes were prepared by collaborators at Queen’s University
Belfast, Belfast, Northern Ireland. Negatively charged miR-26a and antagomiR-133a were
incubated with positively charged RALA peptides for 30 minutes at room temperature to
allow nanoparticles to form via electrostatic interaction. Nanoparticles were lyophilized
prior to shipment and rehydrated with pure water prior to use. All nanoparticle complexes
were prepared with an N:P (the molar ratio of positively charged nitrogen atoms in the
peptide to negatively charged phosphates in the miRNA) of 8.
3.2.3 Collagen-Hydroxyapatite Scaffold
Scaffolds were prepared by collaborators at the Royal College of Surgeons, Dublin,
Ireland, as previously described using a freeze-drying technique [14]. Scaffolds were cut
into discs with an 8mm diameter and a 2mm height. Scaffolds were rehydrated and shaken
overnight in 2 ml DPBS per scaffold. They were then chemically crosslinked twice for 2
hours using 0.77 mg 1-(3-Dimethylaminopropyl)-3-ethylcarbodiimide hydrochloride
(EDAC) and 0.18 mg N-hydroxysuccinimide (NHS) dissolved in 2 ml pure water per
scaffold. In between crosslinks, the excess EDAC and NHS mixture was washed off using
2 ml DPBS per scaffold. After the final wash, scaffolds were stored in DPBS for no longer
than 7 days before use. The collagen-hydroxyapatite scaffolds were then soak-loaded with
20 µl of nanoparticle solution or pure water.
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3.2.4 Experimental Design and Surgical Procedure
The animals were randomly divided evenly into 4 treatment groups. Each group
received a collagen-hydroxyapatite scaffold soak-loaded with one of four treatments (A)
pure water (Gene free) (B) 1 µg miR-26a (C) 1 µg AntagomiR-133a (D) .5 µg of miR-26a
and .5 µg of AntagomiR-133a. All microRNAs were delivered as RALA nanoparticle
complexes.
Surgical guidelines were based on previously published protocols [16]. Animals
were weighed and subcutaneously injected with buprenorphine hydrochloride (.05mg/kg)
as a preemptive analgesic at least 30 minutes before surgery. Animals were then
anesthetized via isoflurane inhalation (2.5%-3.5%) to effect. Appropriate depth of
anesthesia was determined by breathing rate and lack of eye blink, tail pinch, and toe pinch
reflexes. Animals were then subcutaneously injected with cefazolin (20mg/kg) as a
prophylactic antibiotic and sterile saline (5mL/kg) to account for fluid losses during
surgery. Animals’ ears were pierced with an ear tag identifier. The incision site was shaved
and disinfected with Isopropyl Alcohol and Chlorohexidine. Animals were then transferred
to the surgical table and placed on a sterile drape on top of a warming therapy pad (38°C)
for thermal support. A fenestrated drape was then placed over the animal. During surgery,
anesthesia was maintained via a nose cone, and depth was assessed using breathing rate
and lack of eye blink, tail pinch, and toe pinch reflexes.
All surgical procedures were self-performed using aseptic techniques, conditions,
and equipment. Throughout the entire procedure, gauze and sterile saline irrigation were
used to clean the surgical site and manage bleeding. A midline incision was made through
the skin and periosteum along the sagittal suture. The periosteum was laterally contracted
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using an elevator to expose the underlying calvaria. A dental drill in combination with a 7mm trephine operating at 1500rpm was used to create a 7-mm unilateral circular
transosseous defect. Extreme caution was taken not to damage the underlying dura mater.
An elevator and Brown-Adson forceps were used to lift and remove the disk of bone from
the defect area. Soak-loaded scaffolds were then gently pressed into the defect region. The
periosteum and skin were then both closed using 4-0 monofilament absorbable sutures.
Wound clip staples were then placed over the incision, finalizing the surgical procedure.
Animals were left to recover on a heating pad until fully awake. Once awake,
animals were placed back into cages. Animals received subcutaneous injections of
buprenorphine hydrochloride (.05mg/kg) 12-, 24-, and 36-hours post-surgery as a
postoperative analgesic. Animals were weighed and monitored for signs of distress daily
up to 8 days post-surgery. Four animals were lost due to complications, resulting in an n=8
for group A, n=7 for groups D and C, and an n=6 for group B. No implant rejections or
inflammatory reactions were observed in any of the surviving animals.
3.2.5 Micro-Computed Tomography
Scans
Micro-Computed Tomography (µCT) was performed in vivo 4- and 8-weeks postsurgery. Animals were then anesthetized using via isoflurane inhalation (2.5%-3.5%) to
effect, then placed cylinder sample holder inside the µCT (Bruker Skyscan 1276).
Anesthesia was maintained via nose cone throughout the entire scan. Ear identification tags
were taped away from the region of interest, as to not interfere with scanning. Animals
were scanned with a voxel size of 40 µm and a 1 mm aluminum filter. The x-ray tube
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voltage was 60 kV, the current was 125 µA, and the exposure time was 539 ms. Images
were collected every .800º using a 360º rotation around the sample.
Image Reconstruction
Three-dimensional image reconstructions were performed using NRecon (Bruker).
Mis-alignment compensation varied from scan to scan to ensure that images were of the
highest quality. All reconstructions were done with the same dynamic range of 0 to
.052639. A universal beam hardening of 30%, a Gaussian smoothing of 2, and a ring
artifact correction of 10 were used on each set of images. Images were then exported as
TIF Files. Following NRecon reconstruction images, images were imported into
DataViewer. Using DataViewer images were aligned and datasets of coronal planes were
saved. Each animals’ week 4 and week 8 scans, were aligned using DataViewer’s 3D
registration. This was done to ensure that the region of interest was kept in the same
location for both time points.
Analysis
Two different volumes of interest were used for analysis in this study. This first
was a larger cylindrical volume of interest that encapsulated all bone growth within the
height of the defect area as well as any bone that may have formed outside the defect. This
VOI had a diameter of 6.8mm and variable height that ranged the height of the bone growth
to the bottom of the defect (figure 3.1). Using this VOI, total bone volume and tissue
mineral density were quantified. This will be referred to as the large VOI.
The second volume of interest was used to study bone only within the defect region.
This was also a cylindrical VOI with a diameter of 6.8mm. The height for this VOI was
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equal to the height of the native skull (figure 3.1), which slightly varied from rat to rat (1.72
± .27 mm). This VOI will be referred to as the small VOI. Using this VOI, Bone Volume,
Tissue Mineral Density, and Bone Mineral Density were quantified. Tissue Mineral
Density is defined as the average mineral density of the bone excluding surrounding soft
tissue, while Bone Mineral Density is the average mineral density of the entire VOI.
Percent filled, defined as the bone area over the total area of a 2D projection of a top-down
view through all the slices in the defect space was also quantified using this VOI. All
individual slices from the small ROI were combined into a single image using Photoshop
and then the single slice was uploaded into CTan where the percent bone inside the defect
region was quantified (figure 3.2).
For both VOIs, a threshold of 137-255 on a scale of 0-255 was utilized. This
corresponded to a bone being defined as tissue mineralized >.644 g HA/cm^3. This was
used to distinguish mineralized tissue from poorly mineralized tissue [20].

Figure 3.1: The two different VOI’s used to analyze µCT data. The left image shows
the large VOI and the right image shows the small VOI.
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3.2.6 Histomorphometry
Preparation
Histomorphometric analyses were used to further determine bone growth and
structure within the defect region. The rats were anesthetized at 8 weeks using 2.5% to
3.5% isoflurane and euthanatized via intracardiac exsanguination. The fragment of the
calvarium containing the defect region was then harvested via dissection using a highspeed Dremel. The explants were fixed in 10% formalin for 72 hours, stored in 70%
ethanol, and decalcified overnight in rapid-acting formic acid. They were then embedded
in paraffin wax blocks. Sections (5 µm thick) were cut from the midline of the defect,
deparaffinized, and mounted on slides. Sections were stained with H&E using standard
methods (figure 3.9).
Imaging
H&E Slides were imaged on a Zeiss Stereo Discovery.V20 at a magnification of
80x. Images were taken, tiled, and saved as a .tif using the Zen 2.6 Pro (blue edition)
software.
Analysis
H&E images were evaluated for defect width and bone area using Bioquant Osteo.
Defect width was defined as the shortest distance between bone from the medial side of
the slide to the lateral side greater than 25 µm (figure 3.9). The bone area was quantified
using a region of interest that was 6mm in width and the height of the native skull (figure
3.9). Measurements for the width started at the original lateral defect margin, which was
identified by changes in native bone structure and µCT cross-referencing, and spanned
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6mm towards the medial defect margin. This was done to compensate for any slices that
deviated from the midline, folding, and other possible artifacts from histological
processing. Two samples were lost during processing, therefore, could not be evaluated.
This resulted in an n=7 for the gene-free group, n=7 for antaomiR-133a and miR-26a and
antagomiR-133a groups, and an n=5 for the miR-26a group just for the histomorphometry.
Bone Area was correlated with Bone Volume from small ROI µCT scans to ensure
accuracy (figure 3.12).
3.2.7 Statistical Analysis
A repeated measures mixed model was used to compare healing efficacy between
groups for µCT data, this allowed for all time points to be taken into consideration for each
treatment. Treatments and time were defined as fixed effects, while individual rats were
considered a random effect. Since there was only one time point for histomorphometric
analysis, one-way ANOVAs were utilized. A value of p <0.05 was considered significant.
A failure to reject the null hypothesis was not necessarily demonstrated by our data so a
post-hoc power analysis was also conducted for the bone volume. This was done using the
averages, standard deviations, and sample size of the gene-free (5.43 mm3 ± 2.13, n=8) and
the miR-26a (10.32 mm3 ± 5.28, n=6) groups because they were the control and highest
responder respectively. An alpha of .05 was utilized and a power of >80% was considered
strong enough to reject the null hypothesis. All graphs are represented as mean ± 1 SE.
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3.3 Results
3.3.1 Animals
As previously mentioned, four animals were lost due to complications including
cage ventilation issues, blood loss during surgery, and post-surgery blood clotting. As a
result, these animals were removed from the study. All animals kept in the study exhibited
no signs of illness, infection, or implant rejection. All animals continued to eat, drink, and
gain weight normally throughout the study.
3.3.2 Micro-Computed Tomography
All four groups showed significant bone growth throughout the time course of the
study (p=0.00003). For the evaluation of the large VOI, there was no significant difference
in bone volume (p=0.13875) or tissue mineral density (p=0.44569) between the groups.
For the evaluation of the small VOI, there was no significant difference in Bone Volume
(p=0.14126), Tissue Mineral Density (p=0.61887), Bone Mineral Density (p=0.11276), or
Percent Filled (p=0.20349) between the groups. The calculated power between the miR26a and control group was 60% for BV/TV. There was a small standard deviation (3.2%)
within the gene-free group where a much larger deviation (8.9%, 9.1%, and 9.2%) was
detected in all 3 groups receiving microRNAs, implying that there was a variation in
responsiveness to the microRNA treatments but not the gene-free treatments.
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Figure 3.2: 2D Representative coronal view images of the percent of bone filled
within the defect region collected from the µCT scans. White represents bone.

Figure 3.3: Bone Volume of the large VOI (p=0.13875). Mean ± SE.
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Figure 3.4: Tissue Mineral Density of the large VOI (p=0.44569). Mean ± SE.

Figure 3.5: Bone Volume of the small VOI (p=.14126). Mean ± SE.
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Figure 3.6: Bone Mineral Density of the small VOI (p=0.11276). Mean ± SE.

Figure 3.7: Tissue Mineral Density of the small VOI (p=0.61887). Mean ± SE.
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Figure 3.8: Percent Filled of the small VOI (p=0.20349). Mean ± SE.
3.3.3 Histomorphometry

Figure 3.9: Representative images of the calvaria cut on the transverse plane and
stained with H&E. Red lines represent the measurements used for the defect width
calculation. The white ovals are sutures left from the surgical procedure.
Magnification at 80x.
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Figure 3.10: Defect Width from the H&E Stains (p=.1646). Mean ± SE.

Figure 3.11: New bone area from the H&E stains (p=.1325). Mean ± SE.
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Figure 3.12: Correlation between Bone Area from the H&E stains and the Bone
Volume from the small ROI (R2=0.8739) (p<.0001).

New normal bone formation was found within the defect area and scaffolds
appeared to be successfully integrated into the bone in all groups (figure 3.9). Scaffolds
can be seen within both bone and soft tissues, showing that they were not rejected by the
host. Cells can be identified on the surface of new bone, and are hypothesized to be
osteoblasts and osteoclasts, demonstrating that normal bone formation is taking place. In
addition to this, cells can also be seen inside of the scaffold proving that the scaffold was
able to serve as a host for cell migration and that this was not inhibited by the addition of
RALA nanoparticles. For quantitative assessment, there was no difference between groups
in defect width (p=0.1646) or bone area (p=0.1325). A high correlation between bone area
and bone volume was detected (R2=.8739) confirming the accuracy between the µCT data
and the histological data (figure 3.12).
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3.4 Discussion
The goal of this study was to evaluate bone formation using µCT and
histomorphometry in a critical-sized Wistar rat calvarial defect. Collagen-Hydroxyapatite
scaffolds soak-loaded with RALA/microRNA nanoparticles offer the potential for a novel
alternative to currently used bone grafting materials. Currently, no research has been done
to evaluate the healing efficacy using this combination of biomaterials, vectors, and
therapeutics.
In this study, bone formation was evaluated at four and eight weeks in vivo using
µCT. Signs on bone formation were shown at 4 weeks and increased through 8 weeks as
expected. While there was no statistical significance in bone formation between groups, all
groups receiving microRNAs had samples with considerably higher healing responses than
the gene-free group. The group receiving miR-26a had 5 out of 6 rats with higher bone
healing than the average for the control group while the antagomiR-133a group had 5 out
of 7 and the combination group had 6 out of 7. This lack of significance is likely due to the
small sample size and low power (60%). This power is not high enough to reject the null
hypothesis, therefore future studies will need to be conducted with larger sample sizes to
confirm the results.
A large standard deviation of healing responses was also seen in the groups
receiving microRNAs but not in the gene-free group. Similarly, a previous study where
antagomiR-133a was delivered for bone regeneration also showed a large variation in
healing response for the groups receiving the antagomiR treatment, but not the gene-free
groups [9]. The large variation within groups receiving microRNAs also raises the
possibility that genetic variation between rats contributes to the healing response. Similar
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observations have been made in osteoporotic treatment teriparatide, where only certain
patients respond to treatment [19]. Bone also heals normally at different rates between
individuals due to many factors such as age, gender as well as cigarette, alcohol, and drug
usage [21]. To account for these potential genetic variations a follow-up study using
bilateral defect internal controls is necessary.
While the defect regions experienced great bone formation, they did fail to
completely heal in 8 weeks like their BMP-2 counterparts. One cause for this is the
potentially off-targeting of the microRNAs. While antagomiR-133a is specifically
designed to target miR-133a, miR-26a has other targets than just the upregulation of BMPs.
One of these is the downregulation of VEGF which directly affects the proliferation of
endothelial cells and vascularization [24]. Which are both essential for the delivery of
nutrients, oxygen, growth factors, and minerals during bone formation [25]. In addition to
off-targeting within cells, both microRNAs could have targeted other cells than the
indented target. For example, miR-26a has also been shown to be involved in smooth
muscle differentiation and neurogenesis, both tissues found close to the defect site [26, 27].
That being said the microRNAs in this study could have affected different pathways and
cells other than their intended targets. In order to enhance their effect on specific pathways
for bone growth, different dosages and combinations can be explored and proteins can be
quantified to see what exactly is being affected. This will allow for an optimal therapeutic
response from the miRs and allow for an ideal healing response to take place.
The lack of signs of illness, infection, or implant rejection and healthiness of the
rats confirmed that the soak-loaded scaffolds could be implanted without adverse effects.
The histological analysis demonstrated that scaffolds were successfully integrated into
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native bone and soft tissues, reassuring the fact that the implant was accepted by the
subject. It also showed that the treatments promote healing by normal bone formation
activity, as no abnormal tissue formation was observed in any of the groups.
As a whole, this study did have several limitations which may have impacted the
outcomes such as, variation in surgery, and potential genetic variation in rats. One surgical
variation that was different between animals was the time of day that the animal received
surgery. As surgeries are all-day events, some animals undergo treatment early in the
morning, while others receive it late in the afternoon. It has been shown that wound healing
is affected by circadian rhythm and that certain rats might respond differently depending
on what time of day the treatment is administered [22]. Time of surgery also directly
correlates to the length of time the soak-loaded scaffolds are constructed before use. All
nanoparticle/scaffold complexes are prepared at the beginning of the day, however, due to
the length of surgical days, some of these scaffolds have to sit out all day. This allows the
scaffolds more time to soak in the nanoparticles but also allows more time for evaporation
to occur. Both of which could have effects on the administration of the treatment. In
addition to variation in surgery, genetic variation between rats is also highly plausible, one
study found that the genetic variation in rats between vendors, and even within the same
vendor, to be highly divergent [23]. They even went as far as recommending that all in vivo
experiments need to consider the genetic background of all test subjects even if the research
is non-genetics, something that was not done in this study. However, despite these
limitations, we still experienced unique and substantial bone formation from this novel
system which continues leading us down a hopeful path for future studies.
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Overall, the data demonstrated that the scaffolds with microRNAs show promise as
a novel therapy for bone defects. The implanted bone regeneration systems were able to
successfully regenerate normal healthy bone over time. However, future studies will need
to be conducted before consideration of this implant as a clinical alternative to autografts.
3.5 Conclusions and Future Directions
The collagen-hydroxyapatite scaffolds soak loaded with RALA nanoparticles
containing miR-26a and/or antagomiR-133a successfully regenerated bone in critical-sized
calvarial defects. The majority of subjects receiving microRNAs had higher bone
formation than those in the gene-free group. Future studies will focus on modifying the
delivery system and concentrations of microRNAs to obtain more robust and complete
healing responses, adding internal controls to each subject, and larger sample sizes will be
used to increase statistical power. To account for potential genetic variation between
animals, bilateral defects will be utilized, this allows for a treated group and an untreated
group within the same animals. In addition to this, large doses will also be utilized in hopes
this more greatly affects target pathways, therefore, increasing bone formation. Finally,
more rats will be added to each group, allowing for some loss to take place due to the highrisk nature of this study. In conclusion, the findings of this study support the use of this
cell-free implant system as a potential novel clinical therapy, as an alternative to bone
grafting, for treating large bone defects.
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APPENDIX A
SOAK-LOADED COLLAGEN-HYDROXYAPATITE SCAFFOLD
PREPERATION PROTOCOL
Supplies Required:
•
•
•
•
•
•
•
•
•
•
•

1-Ethyl-3-(3-dimethylaminopropyl)carbodiimide (EDAC)
Deionized Water (DI Water)
Dulbecco’s Phosphate-Buffered Saline (DPBS)
Freeze Dried Collagen-Hydroxyapatite Scaffolds
Lyophilized RALA Nanoparticles
N-hydroxysuccinimide (NHS)
Orbital Shaker
Pipette
Pipette Tips
Purified Water
Sterile Falcon™ Tubes

General Notes
•
•
•
•

EDAC is a known toxin and should be handled with care and be properly disposed
of.
The process can be scaled up for larger batches.
All scaffold process for in vivo work should be conducted in sterile environments.
Nanoparticles should not be reconstituted and loaded into scaffolds until ready to
use.

Procedure:
Sterilization:
1. Press UV light button on biosafety cabinet. This should set a timer for 1hr of
UV light within the hood. After one hour the hood should be ready to use.
a. The fume hood window needs to be open to the height of the mark on
the side or the alarm will go off.
2. Wipe down all equipment, including gloves, with 70% ethanol before placing
them into the sterile hood.
Scaffold Rehydration:
1.
2.
3.
4.

Place 2ml of DPBS per scaffold in a small, sterile Falcon tube.
Place scaffolds in the tube.
Shake Gently.
Leave scaffold submerged in DPBS at least overnight.

Scaffold Crosslinking:
1. In a sterile Falcon tube combine:
a. 2ml DI water per scaffold
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2.
3.
4.
5.

b. .77mg EDAC per scaffold (Stored in Refrigerator, let sit outside for 1
hour before use)
c. .18mg NHS per scaffold
Place scaffold into solution, gently shake, and leave in the tube for 2hrs at room
temperature.
Remove scaffold from the solution and place into at least 2ml DPBS, shake
gently and leave submerged for exactly 30 minutes.
Repeat Steps 1-3, so that each scaffold goes through this process a total of two
times.
Place scaffold into fresh DPBS, and store in the refrigerator. Scaffolds need to
be used within one week of crosslinking.

Nanoparticle Rehydration:
1. Add 100 μL of pure water to each vial (each vial contains 5 μg of Cargo).
2. Once initial pure water has been added, pipette solution up and down at least
20 times to mix.
Scaffold Loading:
1. Remove scaffold from DPBS solution and allow the scaffold to dry until moist.
a. A pipette can be used to soak up any excess DPBS surrounding scaffold.
2. Once there is no excess liquid surrounding the scaffold, load 12.5 μL of
nanoparticle solution to the top side of the scaffold, let sit for 15 minutes.
3. Flip the scaffold over and add another 12.5 μL to the top side and let sit for 15
minutes. The scaffold is now ready for implantation.
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APPENDIX B
CALVARIAL DEFECT SURGICAL PROCEDURE PROTOCOL
Supplies Required:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

18G Needles
5mL Syringes
6.8mm Trephine
Adson Brown Forceps
BD Autoclip™ Wound Closing System
Benchtop Protectors
Buprenorphine
Chlorohexidine
Clippers
Controlled Substance Log
Cotton-Tipped Applicators
Disposable Lab Coats
Drapes
Dremel
Ear Punch
Ear Tags
Ethanol
Eye Lubricant
Fenestrated Drapes
Gauze
Green Maxon 4-0 Sutures
Hair Nets
Hemostats
Isoflurane
Isopropyl Alcohol
Kent Scientific Somnosuite®
Lidocaine
Needle Drivers
Nitrile Lab Gloves
Optic Contra Push Button Angle Handle
Phantom Hood
Rat Cones
Rat Holder
Saeyang KRAFIT Ki-20 Dental Implant Motor
Saline
Scale
Scalpel Blade
Scalpel Handle
Scissors
78

•
•
•
•
•
•
•
•
•

Size 50 Clipper Blade
Stryker T/Pump®
Stryker Mul-T-Pads
Surgical Elevator
Surgical Gloves
Surgical Log
Tape
Therapeutic
U100 Syringes

General Notes:
•
•
•
•

This SOP is a reference for a critical-sized calvarial defect for rats. This does not
replace proper training and practice.
It is important to learn sterile techniques before performing surgery.
All steps on the underneath “surgery” should be performed using sterile technique.
Buprenorphine is a Schedule III narcotic, special training and licenses through the
DEA need to be taken before purchasing.

Procedure:
Pre-Surgery:
1. Weigh the rat using the scale, record the weight in the surgical log and in your lab
notebook.
2. At least 30 minutes before surgery give the rat a subcutaneous buprenorphine
injection (.05mg/kg) using a U100 Syringe in the neck region. Record in the
surgical log, lab notebook, and controlled substance log.
3. Place the rat in the Somnosuite chamber operating between 2.5-3.5% Isoflurane
(~500ml/min). It is important to adjust the percentage based on the weight of the
rat. Start at 2.5% for all rats and go from there.
4. Once anesthetized to effect, switch the Somnosuite to the nose cone (~250ml/min)
and transfer the rat to the nose cone. Depth of anesthesia can be assessed using
breathing rate and lack of eye blink, tail pinch, and toe pinch reflexes.
5. Once the rat is transferred, use the low-speed Dremel (5000 RPM) to trim both their
front and back nails.
6. Place a tiny amount of eye lube on the rats’ eyes.
7. Using the ear punch, clip the rat’s ear with an ear tag. Record the ID number in the
surgical log and in your lab notebook.
a. To more easily tell the difference between rats, place even-numbered ear
tags on the right ear and odd number ear tags on the left. However, this is
not mandatory.
8. On the right side of the body, give the rat a subcutaneous injection of sterile saline
(5ml/kg) using a 5ml syringe and 18G needle.
a. It is important to do this slowly, as a large amount of fluid can hurt the rat
if injected too quickly.
9. On the left side of its body, give the rat a subcutaneous cefazolin injection
(20mg/kg) using a U100 syringe, record time in the surgical log.
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10. Using clippers, shave the rat from the bridge of the stout to the back of the skull. It
is important to be liberal with the clipping as this will make surgery easier.
11. Using gauze and chlorohexidine, wipe down the incision site that was previously
shaved. This should help remove any excess hair clippings and clean the head.
12. Using gauze and isopropyl alcohol, wipe down the rat’s head again, finally
prepping the animal for surgery.
Surgery:
1. Using sterile technique, put on a pair of sterile surgical gloves.
2. Place autoclaved, sterile, surgical drape on the surgical table. The table should
already have a Mul-T-Pad set to 38ºC on it and a benchtop protector on it.
3. Have someone who is not the surgeon, move the rat and nose cone onto the drape
being careful not to touch the rat's head or the drape, as this would break the sterile
field.
4. Once the rat is in a comfortable surgical position, carefully place a sterile
fenestrated drape over the rat, leaving the head exposed through the hole. The
drape might need to be folded over to fit completely on the table.
5. Still maintaining sterility, use a scalpel to make a 2-3 cm incision from the bridge
of the nose to the back of the head. Record the starting time in the surgical log.
6. Using the elevator, laterally contract the skin exposing the underlying bone.
7. Using the scalpel score the periosteum and contract it laterally.
8. Using the surgical drill and appropriate size trephine for the study, score the
calvarial with the trephine operating at 1,500 RPM.
a. Use saline and gauze to irrigate the trephine while cutting. This cools the
bone and trephine while removing excess tissue and blood.
b. While scoring the skull, oscillate the trephine back and forth to evenly cut
the defect, this is essential due to the curvature of the skull.
c. The defect location will differ depending on the type of defect. However,
the easiest place is a unilateral defect between the caudal, cranial, and
sagittal defect margins as this decreases bleeding.
d. Caution should be taken to make sure the calvarium is not penetrated too
deeply, as this can damage the dura mater or the brain.
e. An additional lab member should be monitoring the rat for vitals every 10
minutes during surgery and recording in the surgical log.
f. If excess bleeding occurs during this step, do not panic. Stop drilling and
use gauze to apply light pressure for about 90 seconds or until bleeding
subsides.
g. Once the calvarium is cut the entire thickness of the skull, use the elevator
to lift the bone out of the defect region. Be careful not to insert the elevator
too deep or you can damage the brain.
9. Use saline and gauze to wash out the defect before implanting the treatment.
10. Insert the appropriate treatment into the defect region.
11. Using Adson Brown forceps and the elevator, lift and detach part of the periosteum
from the skull, this should allow you to stretch the periosteum over the implant.
12. Once lifted over the implant, suture both sides of the periosteum together using 40 Maxon sutures and needle drivers.

80

13. Finally, close the skin over the periosteum and suture shut using 4-0 Maxon sutures
and needle drivers. Finish off the wound with 3-6 autoclips. Record in surgical log.
14. Move the rat to the Somnosuite heating pad, set at 36ºC, and allow to recover.
While recovering, place a cone over the rat’s head, this can be removed after 24hrs.
Also, administer Lidocaine cream to the wound site to numb the area, this will help
prevent the rat from picking at the wound.
Post-Operative Care:
1. Rats must be given Buprenorphine injections subcutaneously on the neck 12, 24,
and 36hrs post-operation. Record in your lab notebook, surgical log, and controlled
substance log.
2. Rats must be monitored and weighed every day for at least 7 days or until clinically
normal, whichever is longer. This information should be recorded in the surgical
log.
Reference Documents:
•

Spicer, Patrick P et al. “Evaluation of bone regeneration using the rat critical-size
calvarial defect.” Nature protocols vol. 7,10 (2012): 1918-29.
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APPENDIX C
MICRO-COMPUTED TOMOGRAPHY OF IN VIVO RAT CALVARIA (µCT)
Supplies Required:
•
•
•
•
•
•
•
•

Bruker Skyscan 1276
CTAn (Software)
DataViewer (Software)
Isoflurane
Kent Scientific Somnosuite®
Benchtop Protectors
Lab Tape
NRecon (Software)

General Notes:
•

Make sure all appropriate x-ray and µCT training have been taken before starting
the protocol.

Procedure:
Image Acquisition
Scanner Startup
1. Turn on the computer and click Skyscan 1276 software icon.
2. Click on the radiation symbol to begin warming up the scanner.
a. This will take about 15 minutes.
Sample Bed Preparation
1. Select large animal cassette from cassette case, make sure clear anesthesia tube is
screwed in on both ends, black exhaust tube is screwed into the front, and the
appropriate nose cone is screwed in.
2. Click cassette into door and push and slide the red button until locked.

3. Plug Somnosuite directly into Skyscan.
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Setting up Scan
1. Press CTRL+SHIFT+ALT+S to unlock settings.
2. Click on options → scanning modes, change exposure, voltage, and current to
appropriate settings underneath the correct resolutions and filter.
3. Make sure your changed exposure setting is highlighted and check off “update flatfields for marked mode and modes with modified exposures”, click “OK”.
4. Once the flat field is updated, at the bottom of the screen select the appropriate
voxel size, resolution, and filter to match the setting you just changed. The
following settings are optimal for in vivo calvarial scans:
Filter:
Resolution:
Voxel Size (µm):
Voltage (kV):
Current (µA):
Exposure (ms):
Rotation:

Al 1mm
1008 x 672
40
60
125
539
360º
STEP AND
Shooting Mode:
SHOOT
Averaging:
OFF
360 deg scanning:
YES
5. Click Options→Update for current flatfield. This will update the setting for the
currently selected mode.
6. Calibrate DoseMeter:
a. Without the animal in the cassette, turn on the live acquisition by selecting
the TV icon.
b. Options → Dose Meter SHOW/HIDE to make the dose meter window
appear.
c. Select accumulated dose.
d. Click calibration.
Scanning Animal
1. Place the rat in the Somnosuite chamber operating between 2.5-3.5% Isoflurane
(~500ml/min). It is important to adjust the percentage based on the weight of the
rat. Start at 2.5% for all rats and go from there.
2. Once anesthetized to effect, switch the Somnosuite to the nose cone (~250ml/min)
and transfer the rat to the cassette. Depth of anesthesia can be assessed using
breathing rate and lack of eye blink, tail pinch, and toe pinch reflexes.
3. Using lab tape, tape the rat's ear tag back as far as it will go to avoid it interfering
with the scan.
4. Close the scanning door until it locks.
5. Click Actions→Scout and Batch Scan.
6. In the scout view hold CTRL, click, and drag the cursor over the defect region. This
will pull up the Scanning Options window.
a. It is important to keep the number in paratheses at (1) or this will cause
multiple scans to be taken.
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7. In scanning option:
a. Name the file RatXX_WeekXX.
b. Click browse to select the appropriate folder for the images.
c. Set the rotation step, frame averaging, and 360-degree scanning.
8. Click Scan → start scan
9. When the scan is done, delete the scan from the batch, or else it will redo the scan.
10. Repeat steps 1-9 for every rat.
Image Analysis
Image Reconstruction
1. Open the NRecon Software.
2. Click Actions → Open Dataset → Select an image from your µCT scan.
3. Move the green region of interest line to approximately the defect location.

4. Click Start → Fine Tuning →Post Alignment → Start.
5. Using the black arrows at the top of the window, select the clearest image.
a. Take note of the post-alignment values at the top of the image.
b. If the best image is the highest or lowest number, repeat steps 4 and 5 until
the overall best image is selected.
6. Once the best image is selected, click Output, and then click the Attention
Coefficient numbers below the graph.
7. Set the minimum to 0.000000 and the maximum to 0.052639.
a. These numbers have been previously optimized for this study using the data
from the pilot study.
8. Under Advanced → Uncheck Reconstruction 180+.
9. Under Setting → Set values as the following:
Smoothing:
2
Misalignment
Varies depending on
Compensation:
the clearest image
Ring Artifact
10
Reduction:
Beam Hardening
30%
Correction:
10. Click Start → Add to batch.
11. Repeat this step for scans from all time points.
12. When all the scans have been added to batch → Start Batch.
84

Scan Orientation
Note this step is only for scans that are of the first time point
1. Open DataViewer Software.
2. Click Actions → Open → Select any reconstructed image.
3. Click Load for 3D viewing. This will open up 3 windows each with a different
plane view.
4. Using CTRL + Left Click rotate the TRA plane until the defect region is parallel
with the green line.
5. Using CTRL + Left Click rotate the SAG plane until the image is parallel with the
green line.
a. This will should make the COR plane a topdown view of the skull defect
region.

6. Click Actions → Save… → Coronal (X-Z) as a dataset.
7. Repeat this for all the first time point scans.
3D Registration
Note this step is only for scans that are not in the first time point.
1. Open DataViewer Software.
2. Click Actions → 3D Registration.
3. Double click Reference Image and select the first time point Coronal Dataset you
previously saved (from Scan Orientation).
4. Double click Target and select a reconstructed image of the same rat from a
different time point.
5. Click Load.
a. This will load a black image of the first time point and an overlapping white
image of the later time point. This allows the images to be lined up.
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6. Use CTRL + click to rotate the images and the arrows to position them until the
two images line up and create one gray image.
a. If the arrows are moving the image too much or too little click options and
change the shift step.
b. If you are struggling to line the image up, click around on the images to
change the view of the plane.
c. The defect region might change between time points as the defect heals, so
it is best to line up the images using other parts of the scan.
7. Once the images are perfectly lined up → Save.
8. Repeat these steps for all non-first time point scans.
Selection ROI
Note this step is only for scans that are of the first time point
1. Open CTan Software.
2. Open → Select one of the first time point scans.
3. Scroll through images until you find where you want the top of your VOI to be.
a. For the large VOI, this will be the first image of the new bone you see on
top of the skull.
b. For the small VOI, this will be the top of the skull.
4. Select that image → Right Click → Select Bottom of Selection.
a. The images are flipped so the bottom of the selection is the top of the skull.
5. Scroll through the images and find where you want the bottom of the VOI to be.
a. For the large VOI, this will be the last image you see of new bone of the
bottom of the skull.
b. For the small VOI, this will be the bottom of the skull.
6. Select this image → Right Click → Select Top of Selection.
7. Click on Regions of Interest Preview.
8. Find a slice in the middle of your top and bottom selection that accurately depicts
the defect region.
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9. Click on the sunshine icon and select the round option.
10. Double click the dimensions in the bottom right-hand corner of the window. Set
both the width and height to the dimension of your defect region.
11. Drag the now round ROI over the defect region lining it up perfectly with the
original area of the defect.
12. Click Save Region of Interest.
13. Do this for all first time point scans. This will be the same VOI you use for all time
points.
Data Analysis
1. Open CTan Software.
2. Click File → Open → and select the rat and time point you want to analyze.
3. Click Region of Interest Preview → Load regions of interest → Select the VOI that
you previously saved (from Selection ROI) for the rat you’re working on.
4. Click Binary Selection Preview.
5. Click “From dataset”, this will show thresholding for the entire data set instead of
just one image.
6. Change the threshold to 137 to 255.
7. Click Bone Mineral Density and scroll to the bottom of the tab.
a. The Mean (total) is your Bone Mineral Density [g/cm^3].
b. The Mean is your Tissue Mineral Density [g/cm^3].
8. Click Custom Processing Preview.
9. Click on Internal and add the following tasks using the + in this exact order.
a. Threshold
b. Despeckle
c. 3D Analysis
10. Double click on each of these settings and make sure they appear as the following:
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11. Click the run arrow.
12. Open the excel document it creates and record the Bone Volume.
Reference Documents:
• Bruker SkyScan 1276 Manual
• Bruker CT-Analyzer The user’s guide
• Bruker Method Note MTC-009: Bone mineral density (BMD) and tissue mineral
density (TMD) calibration and measurements
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APPENDIX D
RAT EUTHANASIA AND CALVARIA TISSUE COLLECTION
Supplies Required
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

5-10mL Syringe
2 to 3-inch 18G Needle
Somnosuite
Isoflurane
Scalpel Handle
Scalpel Blade
Dremel with Blade
Long-Handle Hemostats
Safety Face Shield
10% Formalin
70% Ethanol
Falcon™ Tubes
Disposable gowns
Benchtop protectors
Ziplock Bags
Phantom Hood
Gauze

Procedure:
1. After the final µCT timepoint place rat in the Somnosuite chamber operating
between 2.5-3.5% Isoflurane (~500ml/min).
2. Once fully anesthetized transfer rats to the nose cone and place them on the table
lying on their back.
3. Insert the 2 to 3 inch 18G needle connected to a 5-10 mL syringe at the mid-section
of their chest in between the bottom of their rib cage. Insert at an acute angle of
about 15º and approximately .5-1 inch deep until you hit the heart. Slowly pull back
on the syringe while inserting.
a. A good indication that the heart has been stuck is the syringe will start filling
with blood. Hold the placement of the syringe once this happens until as
much blood is extracted as possible.
4. Repeat step 3 until an adequate amount of blood has been collected. This will be
approximately between 4-12 mL depending on the rat.
a. You might have to change needles and syringes depending on how clotted
the collected blood becomes.
5. Once the Intra-Cardiac exsanguination has been completed, insert the needle in
between the ribs, hitting the lungs, this will create pneumothorax completing the
euthanasia.
a. The rats are declared euthanized by indication of lack of breathing,
heartbeat, rigor mortis, and pale skin color.
b. Two lab members must declare that the rat has successfully been euthanized
before an incision is made.
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6. Once euthanasia is confirmed the rats are now ready for their calvaria to be
harvested.
7. Use a scalpel to make an incision from the bridge of the nose to the back of the
head, exposing the calvarial
8. Wearing the safety face shield and disposable gown, hold the rat’s neck with the
hemostats and cut around the defect using the Dremel operating at 15,000 RPM.
a. It is important to be liberal with the amount of bone being removed. You
would much rather have extra bone being removed than accidentally cut the
defect region.
b. If the bone is having trouble being removed, re-cut the previously cut
sections until they are completely through and use an elevator to help pop
the sample out.
9. Once the calvaria has been removed place it in a falcon tube in 10% formalin for
72 hours.
10. After 72 hours, remove from formalin and place in a new falcon tube in 70%
ethanol. The bone is now ready for histological processing. Final samples should
look as follows:
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APPENDIX E
CALVARIA HISTOLOGICAL PROCESSING PROTOCOL
Supplies Required
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Ammonium Hydroxide
Cytoseal™-XYL
Distilled Water
Eosin
Epredia™ HistoStar™ Embedding Workstation
Ethanol
Glass Slides
Hematoxylin
Hydrochloric Acid
Leica Autostainer XL
Leica RM2155 Microtome
Polyfin Embedding Medium
Rapid Decal MasterCal™ IM Plus
Sakura Tissue-TEK VIP Processor

General Notes:
•

All samples were processed and stained at the Electron Microscopy and Histology
Core at Augusta University. This is the protocol and equipment they used.

Procedure
Preparation
1. Calvaria explants are decalcified overnight using MasterCal™ IM Plus.
2. The samples are then processed on a Sakura Tissue-TEK VIP Processor.
3. Samples are then embedded in Polyfin Embedding Medium using an Epredia™
HistoStar™ Embedding Workstation.
4. Once embedded blocks are sectioned at 5µm down the midline of defect on the
transverse plane using a Leica RM2155 microtome.
Hematoxylin and Eosin
Before beginning prepare these solutions:
0.25% Acid Alcohol Solution (for differentiation):
•
•
•

2.5 mL Hydrochloric Acid
1000 mL ethanol
Mix well.

0.2% Ammonia Water Solution (Bluing):
•
•

2 mL Ammonium Hydroxide (Concentrated)
1000 mL Distilled Water
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•

Mix well.

Procedure:
1. Place the slides in an oven at 60ºC for 30 minutes.
2. Deparaffinize the sections in 2 changes of xylene, for 5 minutes each.
3. Re-hydrate in 2 changes of absolute alcohol for 3 minutes each.
4. Place in 95% alcohol for 3 minutes.
5. Wash for 5 minutes in running tap water.
6. Stain in Hematoxylin solution for 15 minutes.
7. Wash in running tap water for 5 minutes.
8. Differentiate in .25% acid alcohol for 4 seconds.
9. Wash with running tap water for 2 minutes.
10. Blue in 0.2% ammonia water for 30 seconds.
11. Wash in running tap water for 5 minutes.
12. Counterstain in Eosin for 30 seconds.
13. Dehydrate through 2 changes of 95% alcohol, 2 changes of absolute alcohol for 3
minutes each.
14. Clear in 2 changes of xylene for 5 minutes each.
15. Mount with Cytoseal-XYL.
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APPENDIX F
HISTOMORPHOMETRY ANALYSIS PROTOCOL
Supplies Required:
•
•
•
•

BioQuant Osteo
H&E Rat Skull Slides
Zeiss Stereo Discovery.V20
Zen 2.6 Pro (blue edition) software

Procedure:
Image Acquisition:
1. Remove microscope cover.
2. Turn on Zeiss.
a. Turn on the power box and lightboxes.
3. On the small display screen click “yes” when asked if you want to calibrate the
stage.
4. Open Zen 2.6 Pro (Blue Edition) on the desktop.
a. Two options will appear, select “Zen Pro”.
5. Click “Calibrate” to calibrate the focus.
6. Place the sample on the stage.
7. Click “Acquisition” and change the channel to “Multichannel Experimental Color”.
8. Scroll down to “image setup” and set reflective light to 0% and transmitting light
to 100%.
9. Click “live” and “set exposure”. This will display a live video of the stage on the
screen and set the exposure.
10. Using the joystick move the stage until the sample can be seen on the screen.
11. Using the small display screen click “microscope” and set the magnification to
“80.0”.
12. Back on the main screen go down to the “tile” tab and set a number of X-direction
tiles and a number of Y-direction tiles and click +.
a. The most commonly used tiling for the calvarial defect slides was 7 x 3 for
a total of 21 tiles.
b. BioQuant images need to be under 1 GB to open which is approximately 30
tiles or less.
13. Click “Advanced Set-Up” then “Preview Scan” and “Start Preview Scan”.
14. After the preview scan is done, click the box in the middle and drag to the desired
location.
15. Once the image is in the correct area, click “Start Experiment” to acquire the tiled
image.
16. When the image is done click the save icon under “Images and Documents to save
the .czi file.
a. The .czi will allow you to reopen the image in the Zeiss software.
17. To measure the defect width and create the ROI, click the “Analysis” tab in the top
left corner.
18. Click “Run” then “Start”.
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19. Click and drag the cursor on the image from the tip of the medial side of the
regenerated bone to the lateral side of the regenerated bone. This will measure the
two distances as shown below. This distance will be your defect width.

20. Once the line is drawn the analysis tool will automatically switch to a rectangle.
Draw the rectangle starting from the original defect mark on the lateral side
6000µm towards the medial side.
a. This will be your ROI for bone area analysis.
21. To save the marked-up image click “Processing” then “Image Export”, save the file
type as “Tagged Image Format (TIFF)” and make sure no compression is applied
a. If the file is compressed you will not be able to open it in BioQuant
22. Once you have imported the marked-up .czi file, changed all the appropriate
settings, named your file, and selected the correct folder, click “Apply” to save the
image
23. Once you have done this for all the samples, turn off the Zeiss by closing the
program window, and selecting “Home” and then “Shut Down” on the small
display screen. Shut off both lightboxes and power box and cover the microscope.
Image Analysis
1. Open “BIOQUANT OSTEO”
2. File → Open Image → Select the image you would like to work on
3. The following preparations should be done before analyzing for bone area:
a. Under the drop-down mean “Measure” both “Additive Mode” and
“Subtractive Mode” should be unselected.
b. Selecting the array: Selected List -> D12: Bone Volume (0). Though the
array is labeled as Volume, it measures area.
c. The parameters box should have “Save to Topo Array” unselected.
d. Magnitude should read “Mag: Zeiss_80”. This ensures that BioQuant is
calibrated for the Zeiss at a magnification of 80x.
e. Color (1): selected as dark blue/navy since slides are pink for improved
visibility of outlines.
f. ROI tools: Type: Full Screen.
g. Thresholding wasn’t used so it needs to be turned off. Click on the “R,” “G”
and “B” letters to the right of the sliding color scales so they become gray
and unselected.
h. Make sure to select “Show” so that selected and colored in areas are visible
i. Under the dropdown menu “Transparent” select the level of transparency
desired. Once an area has been colored it will become the appropriate level
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of transparency and can be updated with different transparency selections.
Transparency of 80% is used further in the SOP.
4. Once all settings are changed correctly it should look as follows:

5. Taking measurements of the bone area in ROI:
a. “Calculations” and “Raw Data” windows:
i. To open them:
1. Arrays -> Raw Data
2. Arrays -> View Calculations …
ii. To see the collected data in the array:
iii. In “Calculations” Window: File -> Select New Arrays -> double
click “P2 BV (0)” so that it is transferred to the box “Destination:
Display Page A” then click “Ok” at the bottom to save changes. “P2
BV” calculates the sum of all of the “D12” Bone Volume
measurements.
iv. Update precision to four decimal places, under “Calculations”
window click “Data”, then “Precision…” and set it to 4.
b. Selecting perspective:
i. Once the perspective is moved on the “Large Image Navigator”
Window, everything drawn on the image window will be forgotten
unless the drawings are previewed and measured! Take your time in
selecting a viewing perspective and only move it once everything
has been outlined, drawn, and measured.
c. Drawing and Outlining the Bone Area:
i. Editing Elements:
1. 1st row: 1st column: Pencil for drawing
2. 2nd row: 1st column: eraser for erasing
3. Note: To change the diameter of the eraser or pencil circle,
pinch together/away on the touchpad or scroll on the mouse.
4. 4th row: 1st column: selecting tool - right-click on this icon
and then you can right-click on all of the drawn areas that
you want to include and once you left click off of the icon,
all other non-selected drawn areas will disappear and thus
won’t be previewed and measured.
5. 1st row: 2nd column: shrinks drawn areas
6. 2nd row: 2nd column: dilates drawn areas - is useful when
there are many small little holes so that when you dilate a
section those holes will be engulfed by the drawn patches.
Note that if you dilate small details, once they merge
together or with other drawn sections, if you try to shrink
and unmerge them, they will shrink as one large mass (fine
details will be lost)
7. 3rd row: 2nd column: Fills holes - if you click on a border of
a shape, it will fill all of those holes within the border.
95

8. 4th row: 2nd column: Fills holes - if you click on a hole
within a shape, it will fill in just that single hole within the
shape. Note, this tool is very helpful but will not work if an
outline is not completely sealed (there must be no gaps).
9. 4th row: 4th column: Undo button - this button is extremely
helpful for when you accidentally unselect something, erase
something needed, etc. DO NOT use the undo button in the
threshold section, as this will completely erase everything
drawn in your image window. If you do happen to
accidentally use it, click the undo button in the editing
section and it will bring you back to your second to last
drawing result.
10. Hot Keys/helpful knowledge:
a. Z - zooms in (2 different zoom-in modes)
b. B - pencil/drawing
c. N - eraser/erasing
ii. Click on the pencil icon (first row, first column in editing top
section), and click and hold down on the touchpad/mouse to outline
the bone growth:
1. Once you are done drawing, left click and BioQuant will
recognize that the user is done drawing. The outline will
become yellow as BioQuant recognizes the drawing.

2. Then select the bucket icon and right-click inside of the
outline so that it becomes green.

3. In the measurement section, press preview so that the
selection will become light blue with a dark blue outline.
Then click “Measure”. This will quantify the region and
update the calculations and Raw Data Tables.
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4. This process is then repeated until all individual bone
sections within the ROI are measured. The image below
shows the final outline of all the bones being measured in the
ROI of a single sample.

6. Saving All Data:
a. Saving Image Plus Graphics:
i. Each measurement image was saved with the blue BioQuant
outlines as follows: at the top, in the Image section -> Save Image > Save Image Window Plus Graphics.
b. Saving Topo Overview:
i. At the top, Topo -> Overview …
ii. The image was collected using the snipping tool.
c. Saving Bone Area Calculations:
i. The P2 BV (which is the summed “D12” values) was recorded onto
an excel sheet for later analysis.
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